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Introduction
This manual describes how to access and use the Quanum® Enterprise Content Solutions (ECS) Intelligent
Data Capture (IDC) application. It is primarily intended for Operators and Administrators of IDC, and
provides a reference of end user functionality and tasks.
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Documentation Conventions
This manual uses the following conventions:

• Special terms, webpage and dialog box titles, menu items, toolbar button names, labels that appear on
webpages and dialog boxes, and keyboard key names appear in italic.

Italic is also used to indicate variables. For example, an email address might be presented as
name@company.com. When typing the address, you would use the actual username and company name
rather than name and company.

• Words that are being emphasized appear in bold.

• Text that you type as well as messages and prompts that appear on the screen appear in this type
style.

• The greater than symbol (>) indicates a series of menu items to click. For example, the instructions to
click the File menu item and then click Open will be presented in the following way: “Click File > Open.”

• This manual calls your attention to important information in the following way:

Tip: A tip contains information that, while not essential, might make your task easier.

Note: A note indicates exceptions to the stated rule, or information that emphasizes or supplements
important points in the main text. A note can supply information that might apply only in a special
case.

Caution! A caution indicates that failure to take or avoid a specified action could result in losing data.
When you see a caution, follow the instructions carefully.
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Quanum ECS Intelligent Data Capture Product Overview
Quanum ECS Intelligent Data Capture (IDC) is a web-based document processing solution which allows
organizations to ingest documents received through various means like paper, fax, or email, and to extract
metadata from the documents. Metadata extraction relies upon the index fields and rules defined for the
document types in the associated batch class; IDC does not extract any other data from the Quanum ECS
database than is defined by the rules. To perform document processing, IDC leverages Ephesoft Transact,
an industry-leading solution which automates the end-to-end document processing workflow with minimal
user interaction.

Document Processing Workflow

• Document
ingestion

• Supports
electronic and
paper formats

• Document
assembly/splitting

• Document type
classification

Metadata
extracted from
the documents
based upon
defined
extraction rules

Operator
validation for
extracted data
that does not
meet the
minimum
confidence level

Documents and
metadata exported
to the appropriate
destinations in
Quanum ECS

Notes:

• Batch instances which contain at least one document that IDC was unable to classify are assigned a
status of Ready for Review and Operators can manually correct assembly and classification for these
documents from the Review page.

• Batch instances that contain at least one field in which IDC was not confident are assigned a status of
Ready for Validation and Operators can manually correct information, or provide missing information
from the Validate page.

For more information, see "Navigating the Review and Validation Pages" on page 70.

User Roles

The resources (ie, IDC apps, batch classes, etc) available to IDC users is determined by their role, and the
permissions given to that user role. In Quanum ECS, System Administrators identify new or existing user
groups in Security Manager as an Intelligent Document Capture Group. These groups are then used to estab-
lish Administrator and Operator roles in IDC. See the Add Groups topic in Security Manager help for more
information about making groups available as an IDC role.

The following describes the permissions typically granted to the Administrator and Operator roles in IDC:

• Administrator. Users with Administrator permissions can manage batches by adding new document
types, building extraction and validation rules, and configuring work flows for each batch class.
Administrators can also view batches and restart or delete batches, if necessary.

• Operator. Users with Operator permissions can upload documents for batch processing and review
documents that Ephesoft has determined were not classified correctly. Operators can validate the
exceptions and, if necessary, manually populate the fields in question.

2Chapter 1: About Intelligent Data Capture
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Navigating IDC
This section describes the main features that are available in the IDC navigation menu. To access the nav-
igation menu, hover over the left-hand tab.

Note: The menu options available to users is determined by their role in IDC. Administrators can access
all of the Administrator and Operator menu options. By default, Operators can only access the Operator
menu options; however, they can be granted access to Administrator options such as Batch Class
Management, if needed. The System Configuration menu option is exclusive to Administrators. For
assistance with accessing the Administrator options, contact Quanum ECS Technical Support.
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Administrator Menu Options

Option Description

Batch Class Management Area where all existing batch classes appear and where Admin-
istrators can add, remove, and configure batch classes (eg, creating
workflows, classification rules, extraction rules, document types,
index fields, and extraction rules).

For more information about batch class management, see "Batch
Class Management" on page 20.

Batch Instance Management Dashboard that displays all batches that are currently being pro-
cessed, as well as a real-time status per batch in the overall work-
flow. This enables Administrators to monitor work and intervene when
an error occurs with a batch instance. Additionally, Administrators
can view which batches are currently locked for use by other users
and to test new batch classes.

Folder Management Several files are created as batch instances are processed and writ-
ten to an area on the server defined as SharedFolders. This applic-
ation provides a way to access that folder, and can be used for
troubleshooting.

System Configuration Administrators can use the System Configuration interface to manage
user security, database connections, licensing, security tokens and
keys, and the regular expression pool.

Reports Provides access to standard and advanced reports that enable Admin-
istrators to view performance data for IDC.

Note: Advanced reports are available for an additional fee, so not all
sites will have access to these reports.

For more information about standard and advanced reports, see
"Reporting" on page 105.
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Operator Menu Options

Option Description

Batch List Displays all batch instances waiting for review or validation. If there
are batch instances for review, the Review list appears in the Batch
List by default; otherwise, the Validation list appears, even if there are
no batch instances to validate. Operators can click the Review or
Validation button at the top of the page to switch between the two
lists.

To manage a batch instance, Operators can double-click an instance
in the list, or select a batch instance and then click Open. The batch
instance opens in the Review or Validate page as appropriate.

For more information about reviewing or validating a batch instance,
see "Document Review and Validation" on page 68.

Review Validate Displays the next batch instance ready for review or validation based
on rules such as priority or creation date. The batch instance priority
(a numerical value from 1-100 with 1 being the highest priority) sets
the order in which a batch will be executed.

The Review page enables Operators to review and correct document
assembly (how pages are assembled into documents – including
inserting or deleting pages) and classification (what document type is
assigned).

The Validate page enables Operators to correct information or provide
information that is missing in a batch document, as well as change
the document type.

For more information about reviewing or validating a batch instance,
see "Document Review and Validation" on page 68.

Web Scanner Browser-based scanning interface that allows local TWAIN-based
scanners to scan documents directly to IDC.

For more information about web scanners, see "Scanner Installation
and Setup" on page 6.

Upload Batch Provides an interactive environment for Operators to upload electronic
documents into IDC for processing.

For more information about uploading documents, see "Document
Ingestion" on page 58.
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About Scanner Installation and Setup
IDC can ingest both electronic and paper documents. Each batch class has its own set of ingestion points
and multiple methods are supported, including manual methods like scanning. In order to scan documents
into IDC, you need to install the Ephesoft Web Scanner. The Web Scanner allows you to securely scan
documents at your workstation using a local TWAIN-enabled scanner and import them directly in to IDC. To
assist with quickly applying scanner settings like color depth and resolution when using the Web Scanner,
you can define scanner profiles for the batch classes. For information about installing the Web Scanner or
managing scanner profiles, see "Web Scanner Installation" on the next page and "Scanner Profiles" on
page 13.

To learn more about using the Web Scanner to scan documents and initiate batch processing, or to re-scan
or insert pages when reviewing or validating batch instances, see "Scanning Documents" on page 61,
"Rescanning Pages" on page 101, and "Inserting Pages" on page 103.
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Web Scanner Installation
Ephesoft Transact, the tool that is used in IDC, scans and extracts data from documents that arrive in
formats such as paper, fax, and email attachments. If you are scanning documents into IDC, you need to
install the Ephesoft Web Scanner which allows you to securely scan images at your client workstation.

Install the Web Scanner

1 Prior to installing the web scanner on a workstation, do the following:

• Ensure the proper local scanner driver (TWAIN) is installed on your workstation.

• Copy the site’s public CA root certificate from the IDC server. This is the same CA root file that was
imported into the IDC keystore after receiving a signed certificate from the site.

• Copy the site’s public CA root certificate into the folder containing the web scanner installer and
installation batch script "install.bat". The resulting folder contents should look similar to this:

• After copying the certificate to the installation folder, edit the ews-install.bat file by replacing <sites
public CA root certificate file> with the name of the public CA file you copied to this folder.

• Copy this installation folder to a workstation for installation of the web scanner.
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2 To begin the installation of the web scanner, open an administrator command window in the installation
folder and run the install.bat file. The following window may appear:

3 Click Yes.

The output in the command window appears similar to the following:
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4 In your workstation's Program Files directory, locate the EphesoftTransactScannerService file, and then
do the following to set user permissions to Full control:

a Right-click EphesoftTransactScannerService and then click Properties.
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b In the EphesoftTransactScannerService Properties dialog box, do the following:

i Click the Security tab.

ii In the Group or user names list, click Users.

iii Click Edit.
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c In the Permissions for EphesoftTransactScannerService dialog box, do the following:

i In the Group or user names list, click Users.

ii In the Permissions for Users area, select the Allow check box for Full control.

iii Click Apply and then OK.

d In the EphesoftTransactScannerService Properties dialog box, click OK.

The web scanner should now be installed and functional.
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Scanner Profiles
A Scanner Profile is a named set of scanner settings that include things like color depth, resolution, and
duplex. Scanner profiles are defined for a specific batch class that can be selected and applied when using
the web scanner application.

For information on setting up and modifying scanner profiles, see "Creating Scanner Profiles" below and
"Managing Scanner Profiles" on page 15.

Creating Scanner Profiles
Each batch class contains a default web scanner profile that cannot be modified. However, you can create
additional customized profiles to accommodate specific document types and batch classes. Profiles allow
you to assign features like color depth, resolution, and duplexing of pages to a specific profile, which you
then assign to a batch. You can create a scanner profile for any combination of settings that you find to be
useful.

Tips:

• Scanner settings not managed by the scanner profile can often be set in the scanner driver.

• Windows Image Aquisition (WIA) scanner drivers are not supported due to poor quality.

• In scanner profiles, select Paper Size = 0 (PAPER_NONE) for a portrait US letter.

• Create common scanner profiles in BC1 so that they get copied when building new batch classes.

• When using the WebScanner application, you cannot modify individual scanner settings; you can only
select a scanner profile.

• Create separate scanner profiles for black and white, color, and possibly grayscale as well as low
resolution color and high resolution color.

Set up a Scanner Profile

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Batch Class Management.

2 Select the check box (next to the Identifier column) for the batch class you want to manage, and then
click Open.
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3 In the left-hand pane, click Scanner Profiles.

The default profile appears.

4 Click Add.

A new blank profile appears.

5 Enter a profile name.

Note: If a field in the Scanner Profiles configuration screen is missing or invalid, the field will display in
red. Refer to the "Web Scanner Settings" on page 17 for fields available for customization, and their
customized values.

6 When you have completed the fields, click , and then click .
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Managing Scanner Profiles
You can make changes to custom profiles that you have created, copy a custom profile and edit it to make it
unique, or delete a custom profile.

Edit a Scanner Profile

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Batch Class Management.

2 Select the check box (next to the Identifier column) for the batch class that contains a custom scanner
profile, and then click Open.

3 In the left-hand pane, click Scanner Profiles.

The default profile appears.
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4 Select the check box next to the custom scanner profile you want to change and do one of the following:

• Click any field to edit it.

• Click Copy to create an additional, similar profile. You can then edit any of the fields.

Notes:

• The name of the profile must be unique.

• If a field in the Scanner Profiles configuration screen is missing or invalid, the field will display in
red. Refer to the "Web Scanner Settings" on the next page for fields available for customization,
and their customized values.

• Click Delete to remove the profile, then click Yes on the confirmation dialog.

5 When you have completed the fields, click , and then click .
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Web Scanner Settings
The following table provides all web scanner settings available for configuration and their possible values.
The recommended settings for IDC are highlighted.

Settings Possible Values

Current Pixel Type

Recommended Settings:

• For black and white scanning,
set to 0.

• For color scanning, set to 2.

• For grayscale scanning, set to
1.

0: 1-bit per pixel, black and white

1: grayscale, normally 8 but can be 4- or 16-bit

2: RGB color, 24-bit (can also be 48-bit, and rarely 15-, 16-, or 32-bit)

3: indexed color (image has a color table) 8 or 4-bit.

4: CMY color, 24-bit

5: CMYK color, 32-bit

Bit Depth

Specifies bit depth per color
channel (eg, 24-bit RGB has a bit
depth of 8).

Recommended Settings:

• For black and white scanning,
set to 1.

• For color scanning, set to 24.

• For grayscale scanning, set to
8

1: 1-bit per pixel, black and white

8: grayscale, but some scanners may require it to be 4- or 16-bit

24: RGB color, but some scanners may require it to be 48-bit, and
rarely 15-, 16-, or 32-bit

Multi Transfer

Recommended Setting:

Accept the default for all batch
profiles.

True: Scan multiple pages in one session

False: Scan and close the TWAIN session

Hide UI

Hides the source

Recommended Setting:

Set to True to hide the scanner
source user interface. The inter-
face can be used to access addi-
tional scanner settings that can
be enabled per device/software
being used.

True

False
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Settings Possible Values

Select Feeder

Controls the Automatic
Document Feeder (ADF).

True

False

Auto Scan True: Web Scanner will scan pages before they are requested, and
buffer them in the scanner or host PC. Use this option to achieve
maximum throughput on ADF scanners.

False

Enable Duplex

Sets the scanner for duplex
scanning if the scanner supports
it.

True: Scan Duplex

False: Scan Simplex

Blank Page Mode

Signals Web Scanner to detect
and discard blank pages.

True (discard): 1

False (do not discard): 0

Blank Page Threshold

Specifies the ‘dark’ pixel
percentage threshold, below
which the page is considered
‘blank.’

Between 0 and 1.0, The Default blank page threshold is: 0.02 (= 2%
dark pixels).

DPI

This option specifies the dots per
inch.

200

300

Values supported by other scanners

Color 0: 1-bit per pixel, black and white

1: grayscale, normally 8 but can be 4- or 16-bit

2: RGB color, 24-bit (can also be 48-bit, and rarely 15-, 16-, or 32-bit)

3: indexed color (image has a color table) 8 or 4-bit.

4: CMY color, 24-bit

5: CMYK color, 32-bit

Paper Size 0: NONE

1: A4

2: B5

3: US Letter

4: US Legal

19: A0

20: A1

21: A2

22: A7

23: A8

37: JISB3

38: JISB4

39: JISB6

40: JISB7

41: JISB8
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Settings Possible Values

5: A5

6: B4

24: A9

25: A10

42: JISB9

43: JISB10

7: B6

9: US Ledger

10: US Executive

11: A3

12: B3

13: A6

14: C4

15: C5

16: C6

17: 4A0

18: 2A0

26: ISOB0

27: ISOB1

28: ISOB2

29: ISOB5

30: ISOB7

31: ISOB8

32: ISOB9

33: ISOB10

34: JISB0

35: JISB1

36: JISB2

44: C0

45: C1

46: C2

47: C3

48: C7

49: C8

50: C9

51: C10

52: US Statement

53: Business Card

Back Page Rotation Multiple

Specifies the multiples of 90
degrees in which back pages
should be rotated.

1: 90 degrees

2: 180 degrees

3: 270 degrees

Front Page Rotation Multiple

Specifies the multiples of 90
degrees in which front pages
should be rotated.

1: 90 degrees

2: 180 degrees

3: 270 degrees

Enable Rescan Enables or disables rescanning of scanned documents. Rescan is
enabled by default.

Enable Delete Enables or disables the ability to delete scanned document pages.
This property is enabled by default.
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About Batch Class Management
The foundation of IDC's document processing workflow is batch classes. Batch classes provide the global
settings and configurations for the operations performed during the IDC workflow, defining how pages will
be processed from ingestion to export.

The main elements which comprise batch classes include:

• Document Types. A list of the document types that will be supported by the batch class must be
assembled. It is recommended that batch classes only contain the document types that are needed.
There are global document types (can be used by all batch classes) and local document types (apply only
to specific batch classes). For more information about managing global document types, see "Global
Document Types" on page 46.

Note: There is a document synchronization process between Quanum ECS Table Manager and IDC.
When a document type is added, modified, or deleted in Quanum ECS, a corresponding global IDC
document type in BC0 is updated.

• Modules. The batch class modules represent and define the order of stages in the batch processing
workflow, such as Page Process (individual image processing of images/pages within the batch) and
Extraction (extraction of metadata from each document in the batch). These modules act as containers
for plugins.

• Plugins. Within each module are sets of plugins which perform specific operations. You can add, remove,
or change the order of any modules or plugins in the workflow; however some do have a recommended or
required order for performance. For information about custom plugins provided for Quanum ECS, see
"Plugins" on page 27.

• Scanner Profiles. Specific profile configurations such as color depth, resolution, and duplexing of pages
can be created to optimize Web Scanner functionality. Each batch class contains a default Web Scanner
profile; however, Administrators can set up additional customized profiles to accommodate specific
document types and batch classes. These custom profiles are available to Operators for selection when
using the Web Scanner. For more information about managing scanner profiles, see "Scanner Profiles"
on page 13.

The Batch Class Management page displays all of the existing batch classes and enables Administrators to
add, remove, and configure batch classes, as well as backup batch classes using the export function. IDC
provides you with two batch class templates, by default, that you can use to make your own batch classes.
For more information about the batch class templates or tasks related to creating a new batch class, see
"Batch Class Templates" on the next page, "Creating Batch Classes" on the next page, or "Importing Batch
Classes" on page 55. For more information about exporting batch classes, see "Exporting Batch Classes" on
page 54.
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Creating Batch Classes
The foundation of IDC's document processing workflow is batch classes, which provide the global settings
and configurations for the operations performed during the workflow. The basic processes to set up a
workflow in IDC includes creating a batch class, and then performing additional configuration for the batch
class like the following:

• Adding or removing modules and plugins as needed to support the workflow.

• Creating and learning document types. For more information about learning documents, see "Learning
Files" on page 50.

• Creating index fields to extract data from documents.

• Create key-value extraction rules to populate the index fields with the data extracted from a document.

Note: The key-value (KV) extraction rule is the most common way to build out extraction logic, but
there are other extraction rule types that can be created as well.

While you can create and configure batch classes manually, IDC also provides you with templates that you
can use when creating your own batch classes, as well as an option to import a batch class. The BC0 Global
Batch Class template is used to define the global document types that can be utilized in any other batch
class. The BC1 Loose Sheet Template is the base template for all Quanum ECS batch classes (for more
information, see "Batch Class Templates" below). It is recommended that any new batch classes are
created by copying the BC1 batch class and then modifying the new batch class, as needed. For more
information about creating a new batch class by copying the BC1 Loose Sheet Template or by importing a
batch class, see "Create a New Batch Class" on the next page or "Importing Batch Classes" on page 55.

Note: If needed, you can request modifications to existing batch classes or the creation of custom batch
classes by contacting Quanum ECS Technical Support.

Batch Class Templates
IDC provides you with batch class templates that you can use to make your own batch classes. Currently
the following batch class templates are available:

• BC0 Global Batch Class. The BC0 Global Batch Class template is a special batch class where document
types defined here can be made “global”. When a document type is made “global”, it can be used in
other batch classes and any changes made to that global document type will affect all of the batch
classes that use it. For Quanum ECS, these global document types have names and Index field names
that directly map to Quanum ECS document types and document type attributes. These document types
can be defined as either a folder document type or a chart document type depending on how the index
fields are configured. This allows the Export plugin to export the document to Quanum ECS as the proper
document type and with the proper values used as document attribute values. For more information
about managing global document types, see "Global Document Types" on page 46.

Note: If a document type is deleted in Quanum ECS Table Manager, it will no longer be available to
select in IDC.
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• BC1 Loose Sheet Template. The BC1 Loose Sheet Template is the base template for all Quanum ECS
batch classes. New batch classes are created by copying the BC1 batch class and then modifying the
new batch class, as needed. The BC1 Loose Sheet Template includes a reference to all of the global
document types in the in BC0 Global Batch Class. Any changes made to the global document types will
impact your new batch class; however, when any new global document types are added to the BC0 batch
class, they are not automatically added to your new batch class.

By default, the BC1 Loose Sheet Template utilizes modules and plugins to complete the following
workflow:

a Barcode classification

b Lookup document name for bar code value

c Barcode extraction

d Validation process

e Export to Quanum ECS

For more information about the modules and plugins included with the BC1 Loose Sheet Template, see
"Create a New Batch Class" below.

Create a New Batch Class

Note: This topic describes how to create a batch class by copying the BC1 Loose Sheet Template. You can
also create a new batch class by importing a batch class. For more information about importing, see
"Importing Batch Classes" on page 55.

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Batch Class Management.

2 Select the check box (next to the Identifier column) for BC1 LooseSheetTemplate, and then click Copy.
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3 In the Copy Batch Class dialog box, do the following:

a In the Name box, type a name for the new batch class.

Notes:

• The name cannot contain spaces.

• Maximum length is 255 characters.

b In the Description box, type a description for the batch class. Consider using a standard naming
convention, for example the department that will use the batch class.

Note: Maximum length is 255 characters.

c At Priority, leave the default value of 20.

d In the Drop Folder box, it is recommended to replace the last folder of the path with the value for
Name (eg (/opt2/cmax/Ephesoft/SharedFolders/drop-folders/[Name]).

4 Click OK to create the batch.

5 Make additional changes to the batch class, as needed. By default, the BC1 Loose Sheet Template is as
follows:

• Operate as a loose sheet batch that reads Code39 barcodes and use document type barcodes for
Classification, and MRN and Acct# for metadata extraction.

• Only handles chart documents.

• Includes the following modules and related plugins:

Modules Description Related Plugins

Folder Import Includes operations related to the
ingestion of files.

IMPORT_MULTIPAGE_FILES

IMPORT_BATCH_FOLDER

Page Process Includes operations related to
individual processing of
images/pages within the batch.

NUANCE_HOCR

CREATE_DISPLAY_IMAGE

SEARCH_CLASSIFICATION
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Modules Description Related Plugins

MULTI_DIMENSIONAL_CLASSIFICATION

ADVANCED_BARCODE_READER

QECS_BARCODE_MAPPING_PLUGIN

Document
Assembly

Includes operations related to
defining/classifying document(s) (1
or more pages), and assembling the
documents.

DOCUMENT_ASSEMBLER

QECS_COALESCE_ADJACENT_PAGES_
PLUGIN

QECS_REMOVE_DOCUMENT_HEADER_
PLUGIN

QECS_DOCUMENT_SPLIT_PLUGIN_2

QECS_DOCUMENT_SPLIT_PLUGIN

Note: The QECS_DOCUMENT_SPLIT_
PLUGIN has been deprecated; QECS_
DOCUMENT_SPLIT_PLUGIN_2 should be
used instead.

Review
Document

Includes operations related to
reviewing the assembly and
classification of documents within
the batch when Operator
interaction is required.

REVIEW_DOCUMENT

Extraction Includes operation related to the
extraction of metadata from each
document in the batch.

NUANCE_EXTRACTION_PLUGIN

REGULAR_REGEX_EXTRACTION

KEY_VALUE_EXTRACTION

CROSS_SECTION_EXTRACTION

PARAGRAPH_EXTRACTION

ADVANCED_BARCODE_EXTRACTION

MACHINE_LEARNING_BASED_
EXTRACTION

TABLE_EXTRACTION

EXTRACTION_SCRIPTING_PLUGIN

QECS_ENCOUNTER_BATCH_PLUGIN

Automated
Validation

Includes operations related to
validating metadata to determine if
the document is complete.

AUTOMATED_REGEX_VALIDATION

QECS_FIELD_VALIDATION_PLUGIN

AUTOMATED_VALIDATION_SCRIPTING_
PLUGIN
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Modules Description Related Plugins

Validate
Document

Includes operations related to
validating metadata when Operator
interaction is required.

VALIDATE_DOCUMENT

Export Includes operations related to
completing the batch process by
exporting the document to an
appropriate destination, usually
Quanum ECS.

CREATE_MULTIPAGE_FILES

QECS_EXPORT_PLUGIN

CLEANUP

Notes:

• After you create the new batch class (by copying BC1), you should optimize your batch class by
removing the plugins you do not need. Even if a batch class Switch is set to OFF, it will still be
loaded and execute until it is determined that the Switch is OFF.

• For information about the custom "QECS" plugins, see "Plugins" on the next page. For information
about IDC plugins provided by Ephesoft Transact by default, refer to the Ephesoft documentation.
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Plugins
IDC provides you with plugins that help to provide a seamless integration between other Quanum ECS
applications and IDC. Currently the following custom plugins are available:

Note: If needed, you can request modifications to existing custom plugins or the creation of additional
custom plugins by contacting Quanum ECS Technical Support.

• QECS_BARCODE_MAPPING_PLUGIN. In order for IDC to classify a document using barcode classification,
the barcode value needs to match the document type name. The QECS_BARCODE_MAPPING_PLUGIN will
modify the barcode value to match the associated document type name.

• QECS_BATCH_INSTANCE_INFO_PLUGIN. The Batch List and Batch Instance Management pages display a
table of batch instances that can be configured to show and hide columns that display information for
each batch instance. There are four columns that are reserved for custom use. This plugin allows you to
define what information appears in these columns. When this plugin runs, it loops through each
document in the batch instance, building a delimited string of unique values found for the specified
index field.

• QECS_COALESCE_ADJACENT_PAGES_PLUGIN. There is a Quanum ECS Document Type parameter called
Coalesce Adjacent Pages that can be managed through Document Types in Table Manager. In Scan
Operator, this parameter would determine if documents of the specified type positioned adjacent to one
another in the batch would be combined into a single document. This is often used for document types
like Nurses Notes, where a standard bar coded form that is filled out multiple times during a patient stay
would be stored as a single document instead of each page as its own document in the chart. In order to
enable this plugin, the plugin must be turned on in IDC and the document type parameter must be set in
Table Manager.

• QECS_DOCUMENT_SPLIT_PLUGIN. In Quality Review, a user could specify specific pages of a document
to be sent to a specific destination and made into a new document. For example, this was often done
with specific pages of a Cash Posting Report in the PFS department so that the relevant pages would be
attached to the correct chart. To replicate this behavior in IDC, this plugin will duplicate, split, and re-
assemble the document into multiple documents that can be attached to the appropriate charts.

Note: QECS_DOCUMENT_SPLIT_PLUGIN has been deprecated; QECS_DOCUMENT_SPLIT_PLUGIN_2
should be used instead.

• QECS_DOCUMENT_SPLIT_PLUGIN 2. This plugin is a replacement for the QECS_DOCUMENT_SPLIT_
PLUGIN. It allows you to do complex split operations on a document. These operations allow you to
identify static pages that should be included with each split page. This plugin can be configured via file
or through the UI configuration.

• QECS_ENCOUNTER_BATCH_PLUGIN. Encounter Batch is a legacy batch that was supported by the Scan
Operator application. The main difference between Encounter Batch and Loose Sheet batch is that the
Encounter batch type uses a batch header sheet that includes the MRN/Acct (or Cabinet/Drawer/Folder)
for all documents within the batch. In IDC this is supported with the QECS_ENCOUNTER_BATCH_
PLUGIN. This plugin copies the MRN/Acct number from a source document to all of the other documents
in the batch. The source document will most likely be the batch header sheet, but it doesn’t have to be.

• QECS_EXPORT_PLUGIN. The QECS_EXPORT_PLUGIN allows a batch class to send scanned images to
Quanum ECS, so that all scanned documentation is stored in Quanum ECS.
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• QECS_FIELD_VALIDATION_PLUGIN. After data has been extracted from a document and before the batch
is made available to an end user, a validation operation occurs on the current state of the batch. This
operation attempts to ensure that the batch documents can be considered complete. The QECS_FIELD_
VALIDATION_PLUGIN does this initial validation.

• QECS_REMOVE_DOCUMENT_HEADER_PLUGIN. A Quanum ECS document header that was historically
used to provide a document type barcode for a document that does not include one for processing in the
Scan Operator application. It was printed from Scan Operator and included two bar codes; DOCHEADER,
to indicate that this is a document header, and the barcode for the document type as defined in Table
Manager. Scan Operator would use the document header to identify the document type and then discard
the image of the document header so it would not be presented as part of the batch. The QECS_
REMOVE_DOCUMENT_HEADER_PLUGIN allows IDC to recognize the header sheet, use the document type
it represents, and discard the image.

Manage QECS_BARCODE_MAPPING_PLUGIN

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Batch Class Management.

2 Select the check box (next to the Identifier column) for the batch class you want to manage, and then
click Open.

Note: For BC1, this plugin is already added.
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3 In the left-hand pane, click Modules > Page Process.

4 From the Associated Plugins list, click QECS_BARCODE_MAPPING_PLUGIN, and then click to add it
to the Selected Plugins list.

Note: Make sure that the barcode mapping plugin comes after ADVANCED_BARCODE_READER.

5 Click Apply to save the plugin to the module and enable plugin configuration.

6 To configure the plugin, do the following:

a In the left-hand pane, click Modules > Page Process > QECS_BARCODE_MAPPING_PLUGIN.

b In the QECS Barcode Mapping Switch list, click ON or OFF.

7 Click Apply to save your changes, or click Deploy to save your changes and start the workflow.
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Manage QECS_BATCH_INSTANCE_INFO_PLUGIN

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Batch Class Management.

2 Select the check box (next to the Identifier column) for the batch class you want to manage, and then
click Open.

3 In the left-hand pane, click Modules > Document Assembly or Extraction.

Note: While you can place the plugin wherever you find it useful, placing it in the Document Assembly
or Extraction modules may be a logical place. Because the plugin loops through each document in the
batch to find unique index fields, you will want to put the plugin after the point where the data of
interest exists and right before the point where you want to see the data of interest. If document types
are your data of interest, then you would put the plugin after Document Assembly, as that's where the
document is classified. The first point where you can observe data about the batch is in the Review
Document module so you want to make sure the plugin is between these two points. If your data of
interest is collected through extractions, you would place the plugin after Extraction and before
Validate Document to observe data about the batch.

4 From the Associated Plugins list, click QECS_BATCH_INSTANCE_INFO_ PLUGIN, and then click to
add it to the Selected Plugins list.
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5 Click Apply to save the plugin to the module and enable plugin configuration.

Note: The plugin can appear multiple times in a single batch class.

6 To configure the plugin, do the following:

a In the left-hand pane, click Modules, and then click the module to which you added QECS_BATCH_
INSTANCE_INFO_PLUGIN.

b Set the QECS Batch Instance Info Switch to ON. If it is set to OFF, no columns will appear.

c In the Custom 1 - Index Field Name box, type the field name to appear in the first column on the Batch
List and Batch Management pages.

Note: You can configure any, some, or all of the custom columns. If the index field name is blank,
the column is not used.

d In the Custom 1 - Delimeter box, type one or more characters. This box cannot be blank if there is a
field name for this column.

e Repeat steps c and d for the remaining columns.

7 Click Apply to save your changes, or click Deploy to save your changes and start the workflow.

Note: If an index field name is provided, but does not exist in a specific document, no value is added to
the custom column for that document.

For more information on custom column names, see  https://ephesoft.com/docs/kb0011987-be-able-to-
modify-the-custom-column-names/.
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Manage QECS_COALESCE_ADJACENT_PAGES_PLUGIN

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Batch Class Management.

2 Select the check box (next to the Identifier column) for the batch class you want to manage, and then
click Open.

Note: For BC1, this plugin is already added.

3 In the left-hand pane, click Modules > Document Assembly.

4 From the Associated Plugins list, click QECS_COALESCE_ ADJACENT_ PAGES_PLUGIN, and then click
to add it to the Selected Plugins list.

Note: Make sure that the QECS_COALESCE_ ADJACENT_ PAGES_PLUGIN comes after the QECS_
REMOVE_DOCUMENT_HEADER_PLUGIN.

5 Click Apply to save the plugin to the module and enable plugin configuration.
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6 To configure the plugin, do the following:

a In the left-hand pane, click Modules > Document Assembly > QECS_COALESCE_ADJACENT_PAGES_
PLUGIN.

b In the QECS Coalesce Adjacent Pages list, click ON or OFF. The default is OFF.

7 Click Apply to save your changes, or click Deploy to save your changes and start the workflow.

Manage QECS_DOCUMENT_SPLIT_PLUGIN

Note: QECS_DOCUMENT_SPLIT_PLUGIN has been deprecated; QECS_DOCUMENT_SPLIT_PLUGIN_2 should
be used instead. For more information, see "Manage QECS_DOCUMENT_SPLIT_PLUGIN_2" on page 35.

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Batch Class Management.

2 Select the check box (next to the Identifier column) for the batch class you want to manage, and then
click Open.
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3 In the left-hand pane, click Modules > Document Assembly.

4 From the Associated Plugins list, click QECS_DOCUMENT_ SPLIT_ PLUGIN, and then click to add it to
the Selected Plugins list.

Note: Make sure that the QECS_DOCUMENT_SPLIT_ PLUGIN comes after the DOCUMENT_ASSEMBLER
plugin and before QECS_COALESCE_ADJACENT_PAGES_PLUGIN.

5 Click Apply to save the plugin to the module and enable plugin configuration.

6 To configure the plugin, do the following:

a In the left-hand pane, click Modules > Document Assembly > QECS_DOCUMENT_SPLIT_PLUGIN.

b In the QECS Document Split Switch list, click ON or OFF.

c In the QECS Document Type box, type the document type you want to split.

Note: If you want to define different behavior for multiple document types, leave the document type
blank. You can create a configuration file on the server that defines these behaviors and will be
used when this field is blank. For information on how to create this file, contact your QECS
technical representative.

d In the QECS Static Pages box, type the pages you want to remain static. You can enter page numbers
separated by a comma or a page range. You can also use L to symbolize last page followed by the
page number from the end. For example, L1 to symbolize second to last.

e In the QECS Split Every # of Pages box, type the number between pages you want to split. This does
not require you to select static pages.

f In the QECS Delete Original Document list, click TRUE or FALSE. Default is FALSE.

7 Click Apply to save your changes, or click Deploy to save your changes and start the workflow.
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Manage QECS_DOCUMENT_SPLIT_PLUGIN_2

Note: If you have batch classes using the original QECS_DOCUMENT_SPLIT_PLUGIN, and you want to use
the new QECS_DOCUMENT_SPLIT_PLUGIN_2, it is recommended that you turn off the original split class
for your batch. You can copy the xml file from BC1, turn on the QECS_DOCUMENT_SPLIT_PLUGIN_2, and
then modify the property file accordingly.

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Batch Class Management.

2 Select the check box (next to the Identifier column) for the batch class you want to manage, and then
click Open.

Note: For BC1, this plugin is already added.

3 In the left-hand pane, click Modules > Document Assembly.
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4 From the Associated Plugins list, click QECS_DOCUMENT_ SPLIT_ PLUGIN_2, and then click to add it
to the Selected Plugins list.

Note: You can place the QECS_REMOVE_DOCUMENT_HEADER_PLUGIN before the QECS_DOCUMENT_
SPLIT_ PLUGIN_2 in the Document Assembly module to allow you to remove header documents before
running the split plugin.

5 Click Apply to save the plugin to the module and enable plugin configuration.

6 To configure the plugin, do the following:

a In the left-hand pane, click Modules > Document Assembly > QECS_DOCUMENT_SPLIT_PLUGIN_2.

b In the QECS Document Split Switch list, click ON to allow the document to be split.

c In the QECS Document Type box, type the document type you want to split.

Notes:

• If you want to include all document types, enter *.

• If you want to define different behaviors for multiple document types, leave the document type
blank. You can define these behaviors on a properties file on the server. See "Configuring the
Properties File for DOCUMENT_SPLIT_PLUGIN_2" below.

d In the QECS Static Pages box, type the pages you want to remain static. You can enter page numbers
separated by a comma or a page range. You can also use L to symbolize last page followed by the
page number from the end. For example, L1 to symbolize second to last.

e In the QECS Split Every # of Pages box, type the number between pages you want to split. This does
not require you to select static pages.

f In the QECS Delete Original Document list, click TRUE or FALSE. Default is FALSE.

7 Click Apply to save your changes, or click Deploy to save your changes and start the workflow.

Configuring the Properties File for DOCUMENT_SPLIT_PLUGIN_2

You can configure the properties file to set the policies and rules, and configure the data. The configurable
policies map to the last three fields on QECS_DOCUMENT_SPLIT_PLUGIN_2.

Notes:

• If you copy a new batch class from BC1, the directory and property file are created. Edit the property
file as indicated in the comments in the sample file that was created.

• Click "Sample DocumentSplitConfig.properties" on the next page
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Complete the following steps to configure the properties file:

1 In the Administrator options, click Folder Management.

2 Select [BatchClassFolder] > qecs-document-split-plugin > DocumentSplitConfig.properties.

3 Open the properties file and make changes to the following items as necessary:

• POLICY is a list of rules. The rules display in a pipe-delimited format. For example :
SINGLEPAGE|DOUBLEPAGE|DEFAULT

• FORMAT is the way the rules that come from the POLICY are displayed;
staticpages|splitpage|deleteOriginal

Based on the above example,

• The first rule is SINGLEPAGE. An example for the rule format is SINGLEPAGE = L|1|TRUE.

• The second rule is DOUBLEPAGE. An example for the rule format is DOUBLEPAGE = L|2|false.

• The third rule is DEFAULT. An example for the rule format is DEFAULT = 1,X|1|false.

• The VALID VALUES for the rules are:

• Static Pages: Comma-delimited list of pages, examples: 1,L,L1, page 1, second to last page, last
page are included in every new document;1-3 pages 1, 2, and 3 are included in every new
document.

• Split Pages: Numeric value must be value that is > 0 and less than the total pages in original
document.

• Delete Original Document: True or False (case insensitive).

• The LIST OF DOCUMENTS WITH 'RULE' is where you can set up rules for document types. The
document names must match the IDC document types exactly, as they are case sensitive. Example:

QECSDTDOC2=SINGLEPAGE

QECSDTDOC3=DOUBLEPAGE

Sample DocumentSplitConfig.properties

#POLICY LIST CASE SENSITIVE
POLICY=SINGLEPAGE|DOUBLEPAGE|DEFAULT
#
#FORMAT FOR RULES OR POLICY: staticpages|splitpage|deleteOriginal
#
#VALID VALUES FOR STATICPAGES:
# 1,L,L-1 page 1, second to last page, last page are included in every new document
# 1-3 pages 1, 2, and 3 are included in every new document
#
#VALID VALUES FOR SPLITPAGE:
# numeric value must be value that is > 0 and less than the total pages in original
document
#
#VALID VALUE FOR DELETEORIGINAL:
# true or false (case insensitive)
#
#RULES FOR POLICIES (CASE SENSITIVE):
SINGLEPAGE = 1|2|false
DOUBLEPAGE = L|2|false
DEFAULT = 1,X|1|false
#
#LIST OF DOCUMENTS WITH 'RULE' - VALID DOCUMENTS MUST MATCH IDC QECS DOCUMENT TYPE EXACTLY
CASE SENSITIVE:
QECSDT110=DOUBLEPAGE
QECSARADRES=DEFAULT
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Manage QECS_EXPORT_PLUGIN

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Batch Class Management.

2 Select the check box (next to the Identifier column) for the batch class you want to manage, and then
click Open.

Note: For BC1, this plugin is already added.

3 In the left-hand pane, click Modules > Export.

4 From the Associated Plugins list, click QECS_EXPORT_ PLUGIN, and then click to add it to the
Selected Plugins list.

Note: Make sure that the QECS_EXPORT_PLUGIN comes before CLEANUP.

5 Click Apply to save the plugin to the module and enable plugin configuration.
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6 To configure the plugin, do the following:

a In the left-hand pane, click Modules > Export > QECS_EXPORT_PLUGIN.

b In the QECS Export Switch list, click ON or OFF.

c In the QECS Document Output Format list, click PDF or TIF.

Note: The availability of PDF and TIF format are determined by the configuration of the
CREATEMULTIPAGE_FILES plugin. Your preferences for these 2 plugins should match. If you select an
output not configured in the CREATEMULTIPAGE_FILES plugin, it will default to the available format.

7 Click Apply to save your changes, or click Deploy to save your changes and start the workflow.

Create Cabinet/Drawer/Folder for Documents to be Exported

You can use the export plugin to create a cabinet/drawer/folder (CDF) for documents to be exported to by
modifying the properties file that is created by the QECS_EXPORT_PLUGIN the first time it runs. Complete
the following steps to modify the properties:

1 In the Administrator options, click Folder Management.

2 Select [BatchClassFolder] > qecs-export-plugin > qecs-export-plugin.properties.

3 Open the properties file and modify it.

The available rules are:

• Allow Create Cabinet (QECSAllowCreateCabinet) – default false

• Allow Create Drawer (QECSAllowCreateDrawer) – default true

If these rules are more restrictive than the validation rules, the batch will go into error in the QECS_
EXPORT_PLUGIN.

When the plugin creates a folder, the start date is today and the end date is 30 days from today. Also, a
container created by IDC includes a "created by IDC" note. These items cannot be configured here. If you
need to configure these items, see the "Using the ScriptFunctionKey to Create CDF" on the next page.
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Using the ScriptFunctionKey to Create CDF

You can use the ScriptFunctionKey to allow IDC to create Cabinets, Drawers, and Folders (CDF) for
documents to be exported to. A method called CreateFolder has been added to the ScriptFunctionKey and
is available when configuring the Function Key Mapping for a document type. This function will create the
CDF indicated by the current values of the Cabinet/Drawer and Folder index fields.

If a document type is global, it must be configured in BC0. Local document types are configured in the batch
class where it is defined. No mappings are added by default.

Complete the following steps to configure the restrictions:

1 In the Administrator options, click Folder Management.

2 Select [BatchClassFolder] >Scripts>ScriptFunctionKey.java.

3 Search the file for this code:

//Default values. These may be customized for site.--------
private static final String DEF_ALLOW_CREATE_CABINET = "false";
private static final String DEF_ALLOW_CREATE_DRAWER = "true";
private static final DateTime createCDFStartDate = new DateTime().withTimeAtStartOfDay();
private static final DateTime createCDFEndDate = new DateTime().plusDays(30);
//---------------------------------------------------------

4 If you leave the code as it is, you can click the function key to immediately create the folder, which
should then make the Cabinet/Drawer and Folder valid. Otherwise, you can modify the DEF_ALLOW_
CREATE_CABINET and DEF_ALLOW_CREATE_DRAWER restrictions.

5 If applicable, modify the start date and end date.

Manage QECS_ENCOUNTER_BATCH_PLUGIN

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Batch Class Management.

2 Select the check box (next to the Identifier column) for the batch class you want to manage, and then
click Open.

Note: For BC1, this plugin is already added.
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3 In the left-hand pane, click Modules > Extraction.

4 From the Associated Plugins list, click QECS_ENCOUNTER_BATCH_ PLUGIN, and then click to add it
to the Selected Plugins list.

Note: Make sure that the QECS_ENCOUNTER_BATCH_PLUGIN comes last in the Selected Plugins list.

5 Click Apply to save the plugin to the module and enable plugin configuration.

6 To configure the plugin, do the following:

a In the left-hand pane, click Modules > Extraction > QECS_ENCOUNTER_BATCH_PLUGIN.

b In the QECS Multiple Batch Header Support list, click ON or OFF.

c In the QECS Delete Batch Header list, click True or False. Default is False.

d In the QECS Batch Header Document Type box, type the document type that matches the barcode on
the document header.

e In the QECS Encounter Batch Switch list, click ON or OFF.

7 Click Apply to save your changes, or click Deploy to save your changes and start the workflow.
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Manage QECS_FIELD_VALIDATION_PLUGIN

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Batch Class Management.

2 Select the check box (next to the Identifier column) for the batch class you want to manage, and then
click Open.

Note: For BC1, this plugin is already added.

3 In the left-hand pane, click Modules > Automated Validation.

4 From the Associated Plugins list, click QECS_FIELD_ VALIDATION_ PLUGIN, and then click to add it to
the Selected Plugins list.

Note: Make sure that the QECS_FIELD_VALIDATION_PLUGIN comes before AUTOMATED_REGEX _
VALIDATION.

5 Click Apply to save the plugin to the module and enable plugin configuration.
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6 To configure the plugin, do the following:

a In the left-hand pane, click Modules > Automated Validation > QECS_FIELD_VALIDATION_PLUGIN.

b In the QECS Favor Acct# list, click TRUE or FALSE. TRUE indicates that a validation/search using the
account number should be tried first and, if it returns a single chart, overwrite any existing MR# with
the MR# of the returned chart.

c In the QECS User Defined ID is Requiredlist, click TRUE or FALSE.

d In the QECS Event Date is Required list, click TRUE or FALSE.

e In the QECS Owner is Required list, click TRUE or FALSE.

f In the QECS Patient Must Exist list, click TRUE or FALSE.

g In the QECS Chart Must Exist list, click TRUE or FALSE.

h In the QECS Default Use Lost and Found list, click TRUE or FALSE.

i In the QECS Default Date Valuelist, click Blank or Now.

j In the QECS Default Time Zone, click a US time zone.

k In the QECS Field Validation list, click ON or OFF.

7 Click Apply to save your changes, or click Deploy to save your changes and start the workflow.

Validate Documents for Cabinet/Drawer/Folder Creation

The QECS_FIELD_VALIDATION_PLUGIN can be configured to allow a document that is assigned to a not yet
created CDF to be seamlessly exported to Quanum ECS once validation is complete. Since the default rules
are CDF must exist = true, then the rule defaults must be changed to false in the properties file that the
plugin will use to validate.

Complete the following steps to configure the properties file of the QECS_FIELD_VALIDATION_PLUGIN:

1 In the Administrator options, click Folder Management.

2 Select [BatchClassFolder] > qecs-field-validation-plugin > qecs-field-validation-plugin.properties.
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3 Open the properties file and modify.

The available rules are:

• Folder Must Exist (QECSFolderMustExist) – default true

• Drawer Must Exist (QECSDrawerMustExist) – default true

• Cabinet Must Exist (QECSCabinetMustExist) – default true

The properties file affects validation in three places:

• QECS_FIELD_VALIDATION_PLUGIN, which generally executes prior to the Validation UI

• ScriptFieldValueChange, which executes after (focus leaves index field) the Cabinet/Drawer or Folder
value is changed. You can turn this on or off in the VALIDATE_DOCUMENT plugin configuration. The
default is on.

• ScriptValidation, which executes when you click the Validate button in the Validation UI. You can turn
this on or off in the VALIDATE_DOCUMENT plugin configuration. The default is on and typically should
not be turned off.

Manage QECS_REMOVE_DOCUMENT_ HEADER_PLUGIN

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Batch Class Management.

2 Select the check box (next to the Identifier column) for the batch class you want to manage, and then
click Open.

Note: For BC1, this plugin is already added.
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3 In the left-hand pane, click Modules > Document Assembly.

4 From the Associated Plugins list, click QECS_REMOVE_DOCUMENT_HEADER_PLUGIN, and then click
to add it to the Selected Plugins list.

Note: Make sure that the QECS_REMOVE_DOCUMENT_HEADER_PLUGIN comes after DOCUMENT_
ASSEMBLER.

5 Click Apply to save the plugin to the module and enable plugin configuration.

6 To configure the plugin, do the following:

a In the left-hand pane, click Modules > Document Assembly > QECS_REMOVE_DOCUMENT_HEADER_
PLUGIN.

b In the QECS Remove Document Header Switch list, click ON or OFF.

c In the QECS Document Header Value box, use the default value of DOCHEADER or type a new value.

7 Click Apply to save your changes, or click Deploy to save your changes and start the workflow.
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Global Document Types
Global document types can be used by any batch class, while local document types apply only to specific
batch classes. The BC0 Global Batch Class exists to hold all the global document types and is the only
location where global document types can be modified. For information on adding global document types to
BC0, see"Create Global Document Types" below.

Because a global document type can be referenced by any batch class, a change to a global document type
will impact all batch classes that reference it. If you want to make changes to a global document type for
only a specific batch class, you can copy the global document type as a local document type in the batch
class where it has been added, and then modify the local document type. Making changes to a local doc-
ument type will not affect other batch classes. For information on adding a global document type to a batch
class or copying global document types as local document types, see "Add Global Document Types to a
Batch Class" on the next page or "Copy Global Document Types in a Batch Class" on page 48.

Note: There is a document synchronization process between Quanum ECS Table Manager and IDC. When a
document type is added, modified, or deleted in Quanum ECS, a corresponding global IDC document type
in BC0 is updated.

Create Global Document Types

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Batch Class Management.

2 From the Batch Class Management page, double-click the Global Batch Class (BC0).
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3 In the toolbar at the top of the panel, click Doc Type.
A blank row appears at the bottom of the Document Types list.

4 Enter a unique name and description for the document type in the red text box.

Notes:

• The document type name cannot include any special characters (including a period character).

• The document type name cannot be changed once the workflow has been deployed.

5 Select the Global check box.

Note: Once a document type is marked as global, it cannot be reverted back to a normal document
type. If you’re not ready for a document type to be globally available, keep the global check box
unchecked until you have finished configuration.

6 Click Apply.

Add Global Document Types to a Batch Class

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Batch Class Management.

2 Select the check box (next to the Identifier column) for the batch class you want to manage, and then
click Open.
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3 In the toolbar, click Doc Type, and then select Add Global.

4 Select your global document type from the displayed options.

The global document type is added to your batch class and the Global check box is selected.

Copy Global Document Types in a Batch Class

1 Add the global document type to your batch class. See "Add Global Document Types to a Batch Class" on
the previous page

2 In the Document Type list, select the newly added global document type and click Copy.

3 On the Copy Document Type dialog box, do the following:

a Edit the name by typing L_ in front of it.

b Edit the description, if necessary.

c Edit the Minimum Confidence Threshold, if necessary.

Note: Confidence threshold values can vary between 0.00 to 100.00 and indicate the minimum
confidence for the batch to be identified under the document type.
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d Choose either With Learned Files or Without Learned Files.

Note: Learned files include the information that allows you to replicate the batch class on another
system or environment.

e Click OK.

Note: If you chose With Learned Files, you are prompted to click Learn File(s) to regenerate the
indexes.

The global document type you copied now appears as a local document type.

4 You can delete the global document type from your batch class, if necessary, by selecting the global
document type and clicking Delete.

Note: Global document types can be deleted from local batch classes with no impact to other batch
classes.
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Learning Files
Classification is the process used by IDC to identify document types so that the appropriate rules and logic
can be applied to extracted data. This allows IDC to ingest documents of multiple types in a single batch
and act upon each of them according to their own rules. There are multiple classification methods available
for associating document type (eg Search, Image, Barcode, and Keyword). Methods such as Search clas-
sification use learn/sample files to determine document type, while others like Barcode classification do
not. Administrators can upload the learn files to the appropriate document types while managing the batch
class(es). For more information, see "Learn Files" below.

Learn Files

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Batch Class Management.

2 Select the check box (next to the Identifier column) for the batch class you want to manage (typically
BC0, which is your global batch class), and then click Open.

3 Select the check box of the document type for which you want to upload learned files.
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4 Do one of the following in the Upload Learn Files section:

• Click Upload Learn Files and browse to the files on your machine.

• Drag and drop the files associated with the selected document type.

A processing message appears. When processing is complete, another message appears stating the files
have been learned successfully.

Note: When learning files in IDC, it is important that you select the check box of the document type you
wish to learn. Failing to check a specific document type, or selecting two or more document types, may
result in the learned file being listed under all the document types types selected during the learning
process.

5 To view the learned file(s) you uploaded, click View Learn File(s) in the horizontal toolbar.

The files you uploaded appear in the lower part of the page:

6 You can take the following actions on each page of the file you uploaded:

• Delete. Click to delete the page.

• Download. Click to download the page.

• View. Click to view the page.
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View Learn Files

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Batch Class Management.

2 Select the check box (next to the Identifier column) for the batch class you want to manage (typically
BC0, which is your global batch class), and then click Open.

3 Select the check box of the document type for which you want to view learned files.

4 Click View Learn File(s) in the horizontal toolbar.
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The files learned for this document type appear in the lower part of the page:

5 You can take the following actions on each page of the learned files:

• Delete. Click to delete the page.

• Download. Click to download the page.

• View. Click to view the page.
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Exporting Batch Classes
Batch Class definitions contain some of the most important data in the IDC system. Because of this, you
should export your batch classes on a regular basis as a backup. Exporting your batch classes allows you to
transfer the configurations of a batch class. In the event of a system fault that prohibits migrating the
environment to run batches, you still have a record of your batch class configurations.

Export a Batch Class

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Batch Class Management.

2 Select the check box (next to the Identifier column) for the batch class you want to export, and then click
Export.

3 On the Export Batch Class pop-up window, accept the default With learned files, and then click OK.

A .zip file of folders containing the configuration files is created and downloaded to your computer.

Note: Learned files include the information that allows you to replicate the batch class on another system
or environment.
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Importing Batch Classes
IDC provides multiple options for creating a new batch class. In addition to creating batch classes manually
and copying existing batch classes, IDC also allows you to import batch classes via an exported batch class
.zip file. Importing a batch class creates a new batch class with the same configuration and rules defined in
the imported batch class, including local and global document types and related learned files.

Import a Batch Class

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Batch Class Management.

2 In the Import Batch Class section at the bottom of the Batch Class Management page, drag and drop the
document(s) you want to import, or click Select Files and browse to the .zip.
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3 In the Import Batch Class dialog box, do the following:

a In the Batch Class Name box, type the name of your new batch class.

Note: The batch class name must be unique and cannot contain any special characters that are
defined in the properties file.

b In the Batch Class Description box, type a description for your new batch class.

c At Priority, move the slider to select the priority or type a numerical value in the box.

Note: The value can range from 1-100 with 1 being the highest priority.

d At Drop Folder, do one the following:

• Select the Use Existing check box to view and click an existing folder for the new batch class.

• Type a unique folder path for the batch class in the box (eg
(/opt2/cmax/Ephesoft/SharedFolders/drop-folders/[Name]).

e In the How to Handle Global Document Types area, do the following:

• Click an option in the Import Method list. The import method controls how global document types
in the imported batch class are linked to the global batch class in the destination system. For
more information about global document types, see "Global Document Types" on page 46.

• Import as Local Document Types. Creates local document types for the global document types
in the imported batch class.

• Link to Global Batch Class. Links the global document types from the imported batch class to
the global batch class.
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• Click an option in the Imported Global Doc Types list:

Note: These options are only available if Link to Global Batch Class is selected as the Import
Method.

• Create In Global. Creates document types in the global batch class (BC0) if the global document
types in the imported batch class are not defined in the global batch class. The global
document types in the imported batch class are linked to the global document types in the
global batch class.

• Create Locally. Defines imported document types in the imported batch class as non-global
document types if the imported global document types do not exist in the global batch class
(BC0).

• Ignore Missing. Excludes any global document types from the imported batch class that do not
exist in the global batch class.

• Abort Import. Ends the import process if global document types in the imported batch class are
not available in the global batch class of the destination environment.

f In the Import Batch Class area, click one of the following option buttons:

• With Learned Files. Includes the learned document images and data from the imported batch
class. By default, learned data is imported in the imported batch class.

• Without Learned Files. Excludes the learned document images and data from the imported batch
class.

g In the CMIS Mappings area, select one or more of the following check boxes, as needed:

• Export Plugin Properties. Transfers the available plugin properties of the imported batch class.

• Import Configuration. Includes the CMIS credentials and configurations defined under the CMIS
Import screen in the batch class.

• Export Mappings. Imports and overwrites the mapping files defined at Ephesoft_Installation_
DirectorySharedFolders{Batch Class}cmis-plugin-mapping folder.

Notes:

• These mapping files are used for document and aspect mapping in Alfresco.

• The Export Plugin Properties and Import Configuration check boxes are automatically selected
when the Use Existing checkbox for the Drop Folder is not selected.

h Select one or more of the following check boxes, as applicable:

• Roles. Applies the roles from the imported batch class.

• Email Accounts. Includes email account configurations from the imported batch class.

• Import Connections. Imports DB Export and Fuzzy DB connections if they are configured in any
exported batch class.

i In the Encryption area, do the following to determine the encryption algorithm:

• Clear the Use Existing Key check box to apply a new encryption algorithm for the batch class. Click
an Algorithm in the list, and then type the Batch Class Key in the box.

• Select the Use Existing Key check box to include the same encryption algorithm for the imported
and exported batch class.

4 Click OK to create a new batch class.

A confirmation message appears indicating that the batch was imported successfully.
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About Document Ingestion
Document ingestion, or importing, is the process of bringing documents in to IDC for batch processing. IDC
can ingest both electronic and paper documents and supports various electronic formats such as PDF, .tiff,
and .doc. Each batch class has its own set of ingestion points and multiple methods are supported, includ-
ing manual and automatic methods. Manual methods include the Web Scanner and Upload Batch options
available in the Operator menu. Ingestion can occur automatically using monitored network folders or email
accounts configured by Administrators during batch class setup or management.

For more information about the manual ingestion methods, see "Scanning Documents" on page 61 or
"Uploading Documents" on page 66. For more information about monitored folders or email accounts, see
the following sections.

Monitored Folders
Documents can be automatically imported in to IDC using monitored network folders. The monitored
folders, also referred to as drop folders, can be configured by Administrators while adding a batch class.
Drop folders must be unique for each batch class. When document(s) are "dropped" in to the monitored
network folder, a batch instance is automatically created in IDC. Drop folders also serve as the destination
or export folder for any batch instances processed for the associated batch class.
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Monitored Emails
Documents can be automatically imported in to IDC from an email account. While performing batch class
management, Administrators can add an email account for use with IDC. Administrators can also perform
additional configuration to specify which information is imported from an email (documents attached to the
email, content in the body of the email, or both). Multiple email accounts can be set up for a batch class.
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Scanning Documents
You can use the Web Scanner option to manually import documents in to IDC for batch processing. The Web
Scanner option allows you to scan documents using a local TWAIN-enabled scanner and import them
directly in to IDC. The Web Scanner also provides options to preview or manipulate scanned images (eg
rotate, rescan, delete). In order to use scanning, the Web Scanner must be installed on the workstation and
a connection must be established between the local scanner and IDC. For more information about installing
Web Scanner, see "Scanner Installation and Setup" on page 6.

Specific profile configurations are also available to optimize Web Scanner functionality. Each batch class
contains a default Web Scanner profile; however, Administrators can set up additional customized profiles
to accommodate specific document types and batch classes. These custom profiles are available to Oper-
ators for selection when using the Web Scanner. For more information about scanner profiles, see "Scanner
Profiles" on page 13.

The following table describes the options available when reviewing a batch instance. For more information
about using the Web Scanner, see "Scan Documents" on page 63.

Option Description

Left Panel: Thumbnail stack The left portion of the user interface displays a stack of the images.

Middle Panel: Thumbnail list The middle panel displays individual thumbnails of the scanned images.

Main Toolbar

The middle panel also includes the main toolbar, which has the following
options:

• Start. Initiates scanning.
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Option Description

• Stop. Cancels scanning.

• Field(s).

• Finish. Completes the scanning and initiates the batch instance
processing.

• More. Includes the following additional sub-menu options:

• Delete. Removes the selected page(s) from the batch.

• Rescan. Re-scans the currently selected page.

• Insert. Inserts an additional page into the batch.

• Refresh.

• Auto Refresh.

• Shortcuts. Includes all of the keyboard shortcuts supported for
moving between the thumbnail images in the middle panel.

Scan Details

Below the main toolbar are selections for performing the scan (scanner,
batch name, priority level, batch class, and scanner profile).

Right Panel: Image Preview
and Toolbar

The right panel displays a preview of the selected image and the image
toolbar. The image toolbar provides various ways to interact with and
adjust the image preview, including the following:

Move Right/Move Left. Moves the toolbar to the opposite side
of the image preview.

Zoom-in. Zooms in on the image preview.

Zoom-out. Zooms out of the image preview.
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Option Description

Fit Image. Fits the image preview to the window size.

Rotate Clockwise. Rotates the image preview 90 degrees to
the right.

Rotate Counterclockwise. Rotates the image preview 90
degrees to the left.

First Page. Moves to the first page when multiple images are
available.

Previous Page. Moves to the previous page when multiple
images are available.

Next Page. Moves to the next page when multiple images are
available.

Last Page. Moves to the last page when multiple images are
available.

Scan Documents

1 Hover over the left-hand tab to access the navigation menu, and then select Web Scanner from the
Operator options.

The Web Scanner opens.

2 In the scan details area below the main toolbar, do the following:
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a Click the appropriate batch class for the documents being scanned.

b If you are using multiple scanners, select the correct scanner in the scanner list.

c If available, click a custom scanner profile in the list.

3 In the main toolbar, click to scan and import the images.

When the page(s) have been scanned, the image(s) appear in the Web Scanner interface. A stack of
images appear in the left panel, individual thumbnails of images in the middle panel, and a full image of
a selected images appears in the right panel. For more information about the Web Scanner interface, see
"Scanning Documents" on page 61.

Note: If you click again, the images are appended to the previously scanned images.

4 Review the scanned images, and then do any of the following as needed:

• Delete pages. In the middle panel, click the page(s) you want to delete, and then in the main toolbar,
click More > Delete.

Tip: To select multiple pages, press Ctrl and then click the pages.

Note: You also have the option to delete pages from the Validate and Review pages. For more
information, see "Delete Pages" on page 96.

• Rescan a page. In the middle panel, click the page you want to rescan, and then in the main toolbar,
click More > Rescan.

Note: You also have the option to rescan pages from the Validate and Review pages. For more
information, see "Rescan Pages" on page 101.

• Insert pages. In the main toolbar, click More > Insert. Follow your scanner prompts to import the new
page(s) for the batch instance.
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Note: You also have the option to insert pages from the Validate and Review pages. For more
information, see "Insert Pages" on page 103.

• Reorder pages. In the middle panel, click and drag the page(s) to reorder as needed.

Note: You also have the option to reorder pages from the Validate and Review pages. For more
information, see "Reorder Pages" on page 97.

• Manipulate a selected image using the image toolbar. In the middle panel, click an image, and then

click an option in the image toolbar (eg or ). For more information about the image toolbar
options, see "Scanning Documents" on page 61.

Note: You also have option to rotate or resize images from the Validate and Review pages. For more
information, see "Rotate Images" on page 95 or "Resize Images" on page 99.

5 After you are done viewing and manipulating the scanned pages, click in the main toolbar.

6 Click OK to confirm that you are finished scanning.

Batch instance processing is initiated. If a batch instance needs to be manually reviewed or validated, it
will appear in the Batch List with a status of Ready for Review or Ready for Validation. For information
about reviewing or validating batch instances, see "Reviewing Documents" on page 79 or "Validating
Incoming Documents" on page 81.

Note: An Administrator can view batch instance processing from the Batch Instance Management
page. They can also troubleshoot batch instances from this page with an Error status. For more
information, see "Viewing Log Files" on page 153.
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Uploading Documents
IDC enables you to manually upload one or more documents from your computer to initiate batch
processing. The uploaded document(s) will be processed as a single batch instance for the selected batch
class. Once the batch instance has been processed, you can open the batch instance from the Batch List in
order to review or validate, as needed.

Upload Documents

1 Hover over the left-hand tab to access the navigation menu, and then select Upload Batch from the
Operator options.

The Upload Batch page appears.

2 In the Batch Class list, click the appropriate batch class for the document(s).

Note: The uploaded files will be processed as a single batch instance.
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3 In the Upload Files section at the bottom of the page, drag and drop the document(s) you want to import,
or click Select Files and browse to the document(s).

4 If needed, you can delete uploaded files on the Upload Batch page by selecting the check box next to
each document that you want to delete in the file list at the top of the page. and then click Delete File(s).

5 Click to initiate batch processing.

A success message appears indicating the batch instance has been queued for processing, and the
uploaded files are removed from the files list. For information about accessing the batch instance from
the Batch List and reviewing or validating the batch, see "Reviewing Documents" on page 79 or
"Validating Incoming Documents" on page 81.

Note: An Administrator can view batch instance processing from the Batch Instance Management
page. They can also troubleshoot batch instances from this page with an Error status. For more
information, see "Viewing Log Files" on page 153.
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About Document Review and Validation
IDC automates the end-to-end document processing workflow with minimal Operator interaction. There are
instances; however, when the batch contains at least one document that IDC was unable to classify, or at
least one field in which IDC was not confident. These batch instances are assigned a status of Ready for
Review or Ready for Validation and move to the Batch List to await manual intervention. Operators can open
a batch instance from the list and then review and correct document assembly and classification from the
Review page, or correct and provide missing information from the Validate page, as needed. Once Operators
confirm that the review or validation of a batch instance is complete, the instance can proceed to the next
phase in the workflow.

69Chapter 5: Document Review and Validation



Navigating the Review and Validation Pages
The Review and Validate pages enable Operators to manage batch instances manually when the system is
not confident in a document's classification or assembly, or in the data that was extracted from the
ingested documents. Batch instances needing reviewed or validated will not move on to the next phase of
the workflow (data extraction or data and document export) until an Operator takes action on the document
(s) in the instance. Operators can perform actions such as classifying the document type, splitting
documents, merging pages to form a document, deleting unnecessary pages from a document, and
correcting or adding data.

Batch instances that are Ready for Review or Ready for Validation can be accessed from the left-hand
navigation panel by clicking Batch List or Review Validate. Clicking Review Validate opens the next batch
instance ready for review or validation based on rules such as priority or creation date; however, Operators
can click Next Batch to move through the batch instances.

The following sections describe the options available on the Review and Validate pages, and the actions that
can be performed from each page. For more information about the Batch List, see "Navigating IDC" on
page 3.

Review Page
Batch instances which contain at least one document that IDC was unable to classify are assigned a status
of Ready for Review. The Review page enables Operators to correct assembly and classification for
documents in these batch instances. Classification must be completed in order for data extraction to occur.
The following table describes the options available when reviewing a batch instance. For more information
about accessing and reviewing batch instances, see "Reviewing Documents" on page 79.
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Option Description

Left Panel: Document
Types and Pages

The left portion of the user interface displays the documents in the batch using
a red light/green light system, just like in the Validate page. Green indicates no
action is needed, while red indicates an Operator needs to review the document
classification or assembly.

Middle Panel: Review
Document

The middle panel displays the document preview as well as the Document Type
field where Operators can add or edit the Document Type.

When processing multi-page documents, you can reorder the pages from the
middle panel by dragging the pages to reorder as needed.

Main Toolbar

The middle panel also includes the main toolbar, which has the following
options:

• Review. Reviews the currently selected document.

• Next Batch. Proceeds to the next batch. If no batches remain, you will be
redirected to the Batch List page.

• Merge. Used to merge two or more documents together. When selected,
opens a drop-down with the documents in the batch, and the currently
selected document highlighted.

• Merge Selected. Merges all documents selected in the left panel.
Currently selected documents are highlighted gray in the left panel.
Select multiple documents by holding down Ctrl and clicking each
document you want to merge.

• DOC. Merges the currently selected document with another document
selected in the drop-down list.

• Split. Splits a multi-page document into two documents. When selected, a
confirmation message appears.

Note: You cannot split the first page of a document or documents that
contain only one page.
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Option Description

• Table. Enabled for validation only. Replaces the index field view with the
table view.

• More. Includes the following additional sub-menu options:

• Function Key. Includes function key scripts if configured by the
Administrator. If none are available, this sub-menu is disabled.

• External Application. Includes external applications if configured by the
Administrator. If none are available, this sub-menu is disabled.

• Scanning. Includes the following options:

• Re-Scan. Opens the web scanner to re-scan the currently selected
page

• Insert Page(s). Opens the web scanner to insert an additional page into
the batch. For more information, see "Inserting Pages" on page 103.

For more information about scanners, see "Scanner Installation and
Setup" on page 6.

• Next Batch Algorithm. Contains options that control how the next batch
will be chosen, including the following:

• Highest Priority (default)

• Order (Ascending or Descending)

• Learn File(s). Performs machine learning of a document configured with
Search Classification or Multidimensional Classification. For more
information about document learning, see "Learning Files" on page 50.

• Expedite Export. Enabled for validation only. Moves currently validated
documents to a new batch and sends it to the next stage of the workflow
process, if configured.

• Shortcuts. Includes all of the keyboard shortcuts supported during
review.
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Option Description

Batch Details

Below the main toolbar is various information about the batch (batch ID, name,
priority level, and the selected document type).

Right Panel: Image
Preview and Toolbar

The right panel displays the image preview and the image toolbar. The image
toolbar provides various ways to interact with and adjust the image preview
during review, including the following:

Move Right/Move Left. Moves the toolbar to the opposite side of
the image preview.

Split Image. Splits a multipage document into two documents.
Performs the same action as the Split button in the Main Toolbar.

Zoom-in. Zooms in on the image preview.

Zoom-out. Zooms out of the image preview.

Fit Image. Fits the image preview to the window size.

Rotate Clockwise. Rotates the image preview 90 degrees to the
right.

Rotate Counterclockwise. Rotates the image preview 90 degrees to
the left.

First Page. Moves to the first page of a multipage document.

Previous Page. Moves to the previous page of a multipage
document.

Next Page. Moves to the next page of a multipage document.

Last Page. Moves to the last page of a multipage document.

View OCR/View Image. Toggles between the image preview and the
OCR (Optical Character Recognition) data. The OCR view can be
useful when troubleshooting a document that couldn't be
classified, or when data is missing or incorrect, as it allows you to
view the metadata that was extracted from the document. For
more information, see "Viewing the OCR Layer" on page 155.
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Option Description

Magnification Mode. Enabled for validation only. Allows you to
select a portion of the full-page image and view the magnified
selected area.

Duplicate Image. Duplicates a page in the selected document.

Pop Out Image. Opens the image preview in a separate window.

Delete Image. Deletes the selected page(s) from the document. If
you delete all pages in a document, the entire document is
removed from the batch.

For more information about using some of the image toolbar options for
manipulating the document(s) or related images in a batch instance, see
"Manipulating Documents" on page 92.

Validate Page
Batch instances that contain at least one field in which IDC was not confident are assigned a status of
Ready for Validation. The Validate page enables Operators to correct information, or provide information
that is missing in a document, as well as change the document type. Validation must be completed in order
for data and document export to occur. The following table describes the options available when validating
a batch instance. For more information about accessing and validating batch instances, see "Validating
Incoming Documents" on page 81.
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Option Description

Left Panel: Document
Types and Pages

The left portion of the user interface displays the documents in the batch using a
red light/green light system, just like in the Review page. Green indicates no
action is needed, while red indicates an Operator may need to add missing
information or confirm that the data extracted is correct.

When processing multi-page documents, you can reorder the pages from the left

panel by clicking the document icon ( ) in the top left, and then dragging the
pages to reorder as needed.

Middle Panel:
Validate Extracted
Data

The middle panel displays the index fields and data that was extracted from a
document. These fields are configured by the Administrator when setting up the
batch class. Some fields may be highlighted red during validation, meaning that
the field must be addressed by an Operator.

Main Toolbar

The middle panel also includes the main toolbar, which has the following options:

• Validate. Validates the currently selected document and proceeds to the next
document in the batch. Once the last document in the current batch is
reviewed, it will automatically proceed to the next batch.

• Next Batch. Proceeds to the next batch. If no batches remain, you will be
redirected to the Batch List page.

• Merge. Used to merge two or more documents together. When selected, opens
a drop-down with the documents in the batch, and the currently selected
document highlighted.

• Merge Selected. Merges all documents selected in the left panel. Currently
selected documents are highlighted gray in the left panel. Select multiple
documents by holding down Ctrl and clicking each document you want to
merge.

• DOC. Merges the currently selected document with another document
selected in the drop-down list.

• Split. Splits a multi-page document into two documents. When selected, a
confirmation message appears displaying multiple options.
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Option Description

Note: You cannot split the first page of a document or documents that contain
only one page.

These options determine what will be available in the split document:

• Fields. Only extracted index fields.

• Tables. Only extracted table fields.

• Fields and Tables. Both extracted index fields and table fields.

• None. All fields will be empty.

• Table. Replaces the index field view with the table view. This button is only
enabled if an Administrator configures table extraction for the selected
document type. While viewing the table view, you can click the Field View
button to switch to the index field view. For more information, see "Validate
Table Data" on page 85.

• More. Includes the following additional sub-menu options:

• Function Key. Includes function key scripts if configured by the
Administrator. If none are available, this sub-menu is disabled.

• External Application. Includes external applications if configured by the
Administrator. If none are available, this sub-menu is disabled.

• Scanning. Includes the following options:

• Re-Scan. Opens the web scanner to re-scan the currently selected page

• Insert Page(s). Opens the web scanner to insert an additional page into
the batch. For more information, see "Inserting Pages" on page 103.

For more information about scanners, see "Scanner Installation and Setup"
on page 6.

• Next Batch Algorithm. Contains options that control how the next batch will
be chosen, including the following:

• Highest Priority (default)

• Order (Ascending or Descending)
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Option Description

• Learn File(s). Performs machine learning of a document configured with
Search Classification or Multidimensional Classification. For more
information about document learning, see "Learning Files" on page 50.

• Expedite Export. Moves currently validated documents to a new batch and
sends it to the next stage of the workflow process, if configured.

• Shortcuts. Includes all of the keyboard shortcuts supported during
validation.

Batch Details

Below the main toolbar is various information about the batch (batch ID, name,
priority level, and the selected document type), and the Fuzzy Search option if
enabled by the Administrator in the VALIDATE_DOCUMENT plugin configuration
(default is on). The Fuzzy Search option allows you to add missing information to
the index fields by performing a search against the database and then selecting
an item in the Fuzzy Search Results list.

Group Tabs

If configured by the Administrator, the middle panel also displays tabs that group
similar index fields together. Any index field that does not have a group specified
will be assigned to Group 1 by default.

If all index fields in a group have been extracted correctly, the tab will be marked

with a green circle ( ). If any index fields in the group require validation, the tab

will be marked with a red exclamation mark ( ).

Right Panel: Image
Preview and Toolbar

The right panel displays the image preview and the image toolbar. The image
toolbar provides various ways to interact with and adjust the image preview
during validation, including the following:

Move Right/Move Left. Moves the toolbar to the opposite side of the
image preview.

Split Image. Splits a multipage document into two documents.
Performs the same action as the Split button in the Main Toolbar.

Zoom-in. Zooms in on the image preview.
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Option Description

Zoom-out. Zooms out of the image preview.

Fit Image. Fits the image preview to the window size.

Rotate Clockwise. Rotates the image preview 90 degrees to the right.

Rotate Counterclockwise. Rotates the image preview 90 degrees to
the left.

First Page. Moves to the first page of a multipage document.

Previous Page. Moves to the previous page of a multipage document.

Next Page. Moves to the next page of a multipage document.

Last Page. Moves to the last page of a multipage document.

View OCR/View Image. Toggles between the image preview and the
OCR (Optical Character Recognition) data. The OCR view can be
useful when troubleshooting a document that couldn't be classified,
or when data is missing or incorrect, as it allows you to view the
metadata that was extracted from the document. For more
information, see "Viewing the OCR Layer" on page 155.

Magnification Mode. Allows you to select a portion of the full-page
image and view the magnified selected area. You can only have one
magnified area displayed at a time.

Notes:

• When Magnification Mode is enabled, the icon in the toolbar is

green ( ), and the green magnification icon also appears at the
top of the image preview.

• When using Magnification Mode, some other options in the image
toolbar such as Split Image will be disabled.

Duplicate Image. Duplicates a page in the selected document.

Pop Out Image. Opens the image preview in a separate window.

Delete Image. Deletes the selected page(s) from the document. If
you delete all pages in a document, the entire document is removed
from the batch.

For more information about using some of the image toolbar options for
manipulating the document(s) or related images in a batch instance, see
"Manipulating Documents" on page 92.
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Reviewing Documents
Batch instances which contain at least one document that IDC was unable to classify are assigned a status
of Ready for Review and require intervention by an Operator. Batch instances needing reviewed will not
move on to the next phase of the workflow until an Operator takes action on the document(s) from the
Review page. Depending upon the permissible actions defined for an Operator's role, they may be able to
perform actions such as assigning the document type and correcting document assembly (eg splitting
documents, reordering pages in a document, deleting unnecessary pages from a document, and inserting
pages).

Review Documents

1 Hover over the left-hand tab to access the navigation menu, and then select Batch List from the Operator
options.

2 Click the Review button at the top of the page to view batch instances that are ready for review, and then
double-click an instance to open it in the Review page.
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3 In the left panel of the Review page, click the document you want to view.

Notes:

• A red light/green light system is used to indicate which documents in the batch instance need to be
addressed by an Operator. Green indicates no action is needed, while red indicates an Operator may
need to assign or confirm the document type classification for documents in the batch instance.

• Selected documents are highlighted in gray.

4 In the middle panel of the Review page, assign the Document Type by doing one of the following:

• Click the arrow in the Document Type box and then scroll to click the appropriate document type in
the list.

• Type a document type in the Document Type box to narrow the results, and then click the appropriate
document type in the list.

5 If necessary, manipulate the document assembly (eg splitting documents, reordering pages, deleting
unnecessary pages, and inserting pages). For more information about manipulating a document using
options in the main toolbar or image toolbar, see "Manipulating Documents" on page 92.

6 When finished updating the Document Type and correcting the document assembly, click Review.

The document is reviewed and, if IDC determines the document type is valid, it opens the next document
in the batch. Once the last document in the current batch is reviewed, a confirmation dialog box appears.

7 In the Review Done dialog box, click the appropriate option to confirm whether you want the batch
instance to proceed to the next phase of the document processing workflow. If you click OK, the batch
instance moves to the data extraction phase, and the Batch List appears.
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Validating Incoming Documents
As documents are added to IDC, data is extracted from the documents so that they can be properly
identified and validated.

There are three phases to the validation process:

• "Initial Validation" below. This phase validates the documents, searches for missing data, and, if any
document within the batch is still invalid, places them in a Ready for Validation state.

• "Field Value Change Validation" on the next page. When the value of a field is changed during validation,
a script runs that performs additional validation, and when data is available, can automatically makes
changes to associated field values. For information about adding missing data or fixing incorrect data,
see "Correct Index Fields" on page 83 and "Validate Table Data" on page 85.

• "Final Validation" on the next page. This phase validates all fields within the current document when you
select the Validate button.

Note: If there are no errors on any of the documents in a batch, the batch proceeds from the Initial
Validation phase to the Export phase without any interaction from you.

Initial Validation

Chart and folder documents may end up in the validation queue because of issues with the following fields:

Chart Documents

• QECS Document Type: If the document is classified as a document type that cannot be mapped to a
Quanum ECS document type, the document would be invalid. It is rare that this would happen unless the
batch class contains document types that were created directly in IDC rather than through Table
Manager. There is no visual indication if this is the case, but one thing that all valid IDC document types
should have is the form “*QECS*” (where the “*” can be any text and the leading “*” can be blank).

• QECS Medical Record Number and/or QECS Account Number: If either index field is blank, the document
is invalid. The field will be colored red to indicate that it is invalid.

• Lost-N-Found OK: If both the MRN and Account Number can't be validated to a patient or a chart, and
the QECS Lost-N-Found check box is selected, the validation process will enter LOST-N-FOUND to
replace the blank MRN or Account Number field. This action allows the document to continue flowing
through the validation process.

Folder Documents

• QECS Cabinet Drawer. If this index field is blank, the document is invalid. The field will be colored red to
indicate that it must be completed and functions similar to QECSMedicalRecordNumber.

Note: If a value is entered for a Drawer, a Cabinet value must also be entered. A Cabinet value can be
entered without a Drawer.

• QECS Folder. If this index field is blank, the document is invalid. The field will be colored red to indicate
that it must be completed and functions similar to QECSAccountNumber.

Note: If the two fields are not sufficient to identify a single folder, the QECS Cabinet Drawer and QECS
Folder index fields are blank.

• QECS Folder Dates. The start and end dates will be completed if a single folder has been identified.

81Chapter 5: Document Review and Validation



Chart and Folder Documents Common Fields

• QECS Owner Name. This index field is not required to be filled in. However, if it does contain text, the
text will be used to locate a Quanum ECS user. If the text in this field is insufficient to locate a Quanum
ECS user, the field will be colored red to indicate it is invalid.

• QECS Event Date. This index field is not required to be filled in. However, if it does contain a value, it
must be in a defined format (default is mm/dd/yyyy hh:mm). If there is a value and it is not in that
format, the index field will be colored red to indicate it is invalid. A sub-field of QECS Event Date is the
QECS Time Zone field. Both of these fields can be set through a plugin to default to the current date and
time, if the field is blank.

Field Value Change Validation

If you make a change to one of the following fields during the validation process, another validation specific
to the changed field, will be executed:

Chart Documents

• QECS Medical Record Number

• QECS Account Number

• QECS Owner Name

• QECS Event Date

• QECS LostNFound check box

Folder Documents

• QECS Cabinet Drawer

• QECS Folder

• QECS Owner Name

• QECS Event Date

The Document Type validation always runs, regardless of the changes made.

Final Validation

The final validation runs when you click on the Validate page. This final phase allows IDC to make
sure the document(s) are acceptable to export. If the final validation finds the document to be invalid, the
document will remain red. The offending index field will be colored red (unless it's invalid due to document
type) and you will need to make a modification and click the Validate button again. If the document is valid,
it will turn green.
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Correct Index Fields

1 Hover over the left-hand tab to access the navigation menu, and then select Batch List from the Operator
options.

2 Click the Validation button at the top of the page to view batch instances that are ready for validation,
and then double-click an instance to open it in the Validate page.

3 In the left panel of the Validate page, click the document you want to view.

Notes:

• A red light/green light system is used to indicate which documents in the batch instance need to be
addressed by an Operator. Green indicates no action is needed, while red indicates an Operator may
need to add missing information or confirm that the data extracted is correct.

• Selected documents are highlighted in gray.

83Chapter 5: Document Review and Validation



4 Click inside the index fields highlighted in red to manually enter or correct data, or do one of the
following to copy the data from the image preview:

Notes:

• If an Administrator configures table extraction for the selected document type, you can click
in the main toolbar to replace the index field view with the table view. For more information about
using the table view to validate data, see "Validate Table Data" on the next page.

• If you want to view the metadata that was extracted from the document, click in the image
toolbar. For more information about the Optical Character Recognition (OCR) layer, see "Viewing the
OCR Layer" on page 155.

• If the Medical Record Number (MRN) and Account Number are missing or incorrect, and you are
unable to provide that information or capture it from the image preview, you can search for a
patient or their associated MRN and Account Number in other Quanum ECS applications, such as
Navigator, Chart Editor, and Search. For more information about performing a search, refer to the
online help available from the application's Help menu.

• Single word or number set. To copy a word or number set (without spaces) into an index field, click
the highlighted field, and then left-click the text on the image preview.

• Multiple words or number sets. To copy multiple words or number sets into an index field, click the
highlighted field, and then hold down Ctrl while clicking the text on the image preview.

• Line or block of text. To copy a line or block of text into an index field, click the highlighted field, and
then select the text in the image preview by doing the following:

a Right-click once at the starting point of the text to be copied.

b Drag your mouse to highlight the entire line or block to copy, and then right-click again to finish
selecting the text.

5 When finished updating the fields in the document, click in the main toolbar.

The document is validated and, if IDC determines the document is valid, it opens the next document in
the batch. Once the last document in the current batch is validated, IDC automatically proceeds to the
next batch for validation.
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Validate Table Data

1 Hover over the left-hand tab to access the navigation menu, and then select Batch List from the Operator
options.

2 Click the Validation button at the top of the page to view batch instances that are ready for validation,
and then double-click an instance to open it in the Validate page.

3 In the left panel of the Validate page, click the document you want to view.

Notes:

• A red light/green light system is used to indicate which documents in the batch instance need
addressed by an Operator. Green indicates no action is needed, while red indicates an Operator may
need to add missing information or confirm that the data extracted is correct.

• Selected documents are highlighted in gray.

4 Click in the main toolbar to replace the index field view with the table view.
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Note: This button is only enabled if an Administrator configures table extraction for the selected
document type.

5 Click inside the cells highlighted in red to manually enter or correct data.

Notes:

• Hover over the cell to view information about the rules or issue with the data.

• When you click a cell, the extracted data for that cell is highlighted in the table in yellow.

6 When finished updating the cell(s), do one of the following:

• Click . The document is validated and, if IDC determines the document is valid, it opens the
next document in the batch that needs addressed.

• Click . The index field view of the Validate page appears. For information about adding
missing data or fixing incorrect data from the index field view, see "Correct Index Fields" on page 83.
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Exporting to Multiple Destinations
This feature allows users to export a document to several different destinations. For example, if a report
contains payments for multiple patients, select pages of the report may need to go in each patient's chart.
Using the QECS_DOCUMENT_SPLIT_PLUGIN_2, the pages can be replicated and with the export to multiple
destination feature, the user can specify additional destinations for a document.

On the Validate page, the QECS Additional Destinations box appears for specific document types. Users can
edit the field as necessary.

Validate Multiple Destinations

1 Hover over the left-hand tab to access the navigation menu, and then select Batch List from the Operator
options.

2 On the Batch List page, click the Validation button, and then double-click an instance to open it in the
Validate page.
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3 In the QECS Additional Destinations box, type each destination on a separate line by pressing Enter after
each line.

Note: The destinations must be entered in the following format: <mrn>/<acct> or
<cabinet>/<drawer>/<folder>.

4 In the main toolbar, click . The system validates each destination and if one or more is incorrect,
the field is invalid (red) and must be corrected.

Note: If a value is entered for a drawer, but not a cabinet in the Drawer/Cabinet box, that field is invalid
(red) and must be corrected.
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Use Indexing for Batch
The Use Indexing for Batch functionality allows you to copy the primary indexing in a document to all other
documents in a batch. When using this feature, documents must be of a like source for copying. For
example, if the source document is a Chart document, then the MRN and Account # are copied to all other
chart documents within the batch. If the source document is a Folder document, then cabinet, drawer, and
folder are copied to all other folder documents within the batch.

Notes:

• This feature can be applied only to batches with a status of Ready for Validation.

• If needed, this function key script can be configured for use with any of the index fields.

Use Indexing for Batch

1 Hover over the left-hand tab to access the navigation menu, and then select Batch List from the Operator
options.

2 On the Batch List page, click the Validation button, and then double-click an instance to open it in the
Validate page.
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3 On the Validate page, do one of the following:

• Click More > Function Key > Use Indexing for Batch.

• Press F2 on your keyboard.
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Optional Validation Process
Batch classes can be designed to validate that the data meets minimum business requirements to be
exported. If your organization requires further validation, a set of optional validation parameters are
provided:

• QECS Chart Must Exist = TRUE/FALSE

• QECS Patient Must Exist = TRUE/FALSE

• QECS Owner is Required = TRUE/FALSE

• QECS Event Date is Required = TRUE/FALSE

• QECS User Defined ID is Required = TRUE/FALSE

• QECS Favor Acct# = TRUE/FALSE

If you choose to turn on the optional validation parameters, they are all set to TRUE when on and therefore
required in the phase.

In the field value change validation phase, the optional parameters are affected as follows:

• QECS Chart Must Exist, QECS Patient Must Exist, and QECS Favor Acct# are all considered when the
QECS Medical Record Number or QECS Account Number change.

• QECS Owner is Required is triggered if QECS Owner Name changes.

• QECS Event Date is Required is triggered if QECS Event Date changes.

• QECS Chart Must Exist or QECS Defined ID Required is triggered if QECS User Defined ID changes.

For more information on the Optional Validation Parameters, see "Manage QECS_FIELD_VALIDATION_
PLUGIN" on page 42.
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Manipulating Documents
Toolbars on the Review and Validate pages provide options for manipulating the document(s) or related
images in a batch instance. This section describes some of the actions that can be performed using the
toolbar options.

• Split documents. The Split option enables you to create a new document by splitting one or more pages
from a selected document. For more information, see "Split Documents" on the next page.

• Merge documents. The Merge options enable you to combine two or more documents, either by merging
all of documents selected in the left panel, or by merging the document currently selected in the left
panel with a document selected in the Merge drop-down list. For more information, see "Merge
Documents" on page 94.

• Rotate images. The Rotate Clockwise and Rotate Counterclockwise options enable you to rotate the
image preview for a selected page by 90 degrees clockwise or counterclockwise. For more information,
see "Rotate Images" on page 95.

• Delete pages. The Delete Image option enables you to delete one or more pages from a document. If you
delete all pages in a document, the entire document is removed from the batch. For more information,
see"Delete Pages" on page 96.

• Reorder pages. When viewing a document, you can click and drag pages in a document to reorder them.
For more information, see "Reorder Pages" on page 97.
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• Duplicate pages. The Duplicate Image option enables you to duplicate a page in the selected document.
For more information, see "Duplicate Pages" on page 97.

• Magnify a selected area. The Magnification Mode option enables you to select an area in the image
preview to magnify. When the Magnification Mode option is enabled, some options in the image toolbar
are disabled, and some options will function in relation to the magnified area, not the full image. For
more information, see "Magnify a Selected Area" on page 98.

• Adjust the image size. The Zoom-in, Zoom-out, Fit Image, and Pop-out Image options enable you to
adjust the size of the image preview for a selected page. For more information, see "Resize Images" on
page 99.

Split Documents

1 Hover over the left-hand tab to access the navigation menu, and then select one of the following from
the Operator options:

• Batch List. Displays all batch instances waiting for review or validation. Click the Review or Validation
button at the top of the page to switch between the batch instances, and then double-click an
instance to open it in the Review or Validate page.

• Review Validate. Displays the next batch instance ready for review or validation based on rules such
as priority or creation date.

2 In the left panel of the Review or Validate page, click the document that you want to split in to two
documents.

Note: You cannot split the first page of a document or documents that contain only one page.

3 Select the page(s) you want to split in to a new document by doing one of the following:

• Review page. In the middle panel of the Review page, click the page(s) that you want to split from the
selected document.

• Validate page. At the top of the left panel of the Validate page, click to access the document
page view, and then click the page(s) that you want to split from the selected document.

Tip: To select multiple pages, hold down Ctrl and then click each page.

4 Click in the main toolbar, or in the image toolbar.
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5 In the Document Split Confirmation dialog box, click the appropriate option to confirm that you want to
split the document.

Note: The confirmation dialog box has additional options on the Validate page which determine what
will be available in the split document:

• Fields. Only extracted index fields.

• Tables. Only extracted table fields.

• Fields and Tables. Both extracted index fields and table fields.

• None. All fields will be empty.

Once the split is confirmed, the new document appears in the left panel.

6 If needed, from the Validate page, click to close the document page view.

Merge Documents

1 Hover over the left-hand tab to access the navigation menu, and then select one of the following from
the Operator options:

• Batch List. Displays all batch instances waiting for review or validation. Click the Review or Validation
button at the top of the page to switch between the batch instances, and then double-click an
instance to open it in the Review or Validate page.

• Review Validate.Displays the next batch instance ready for review or validation based on rules such
as priority or creation date.

2 In the left panel of the Review or Validate page, click the document(s) to be merged. To select multiple
documents, hold down Ctrl and then click each document.

Note: Selected documents are highlighted in gray.
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3 Click in the main toolbar.

A drop-down containing all of the documents in the batch appears, with the document currently selected
in the left panel highlighted in gray. If you selected multiple documents in the left panel, only the
document selected first is highlighted.

4 Select one of the following Merge options:

• Merge Selected. Merges all of the documents selected in the left panel.

• DOC. Merges only two documents; the document currently selected in the left panel with another
document selected in the drop-down list. If you selected more than one document in the left panel,
only the document selected first will be highlighted and merged with the document you select in the
list.

5 In the Merge Selected dialog box, click OK to confirm that you want to merge the selected documents.

Rotate Images

1 Hover over the left-hand tab to access the navigation menu, and then select one of the following from
the Operator options:

• Batch List. Displays all batch instances waiting for review or validation. Click the Review or Validation
button at the top of the page to switch between the batch instances, and then double-click an
instance to open it in the Review or Validate page.

• Review Validate. Displays the next batch instance ready for review or validation based on rules such
as priority or creation date.

2 In the left panel of the Review or Validate page, click the document you want to view.

Note: Selected documents are highlighted in gray.

3 Select the page that you want to rotate by doing one of the following:

• Review page. In the middle panel of the Review page, click the page that you want to rotate.

• Validate page. At the top of the left panel of the Validate page, click to access the document
page view, and then click the page that you want to rotate.
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4 In the image toolbar, click or to rotate the image preview of the selected page by 90 degrees
clockwise or counterclockwise.

5 If needed, from the Validate page, click to close the document page view.

Delete Pages

1 Hover over the left-hand tab to access the navigation menu, and then select one of the following from
the Operator options:

• Batch List. Displays all batch instances waiting for review or validation. Click the Review or Validation
button at the top of the page to switch between the batch instances, and then double-click an
instance to open it in the Review or Validate page.

• Review Validate. Displays the next batch instance ready for review or validation based on rules such
as priority or creation date.

2 In the left panel of the Review or Validate page, click the document you want to view.

Note: Selected documents are highlighted in gray.

3 Select the page(s) you want to delete from the document by doing one of the following:

• Review page. In the middle panel of the Review page, click the page(s) that you want to delete.

Tip: To select multiple pages, press Ctrl and then click the pages.

• Validate page. At the top of the left panel of the Validate page, click to access the document
page view, and then click the page(s) that you want to delete.

4 In the image toolbar, click to delete the selected page(s).

5 In the Confirm Deletion dialog box, click the appropriate option to confirm that you want to delete the
selected page(s).

Note: If you delete all pages in a document, the entire document is removed from the batch.

6 If needed, from the Validate page, click to close the document page view.
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Reorder Pages

1 Hover over the left-hand tab to access the navigation menu, and then select one of the following from
the Operator options:

• Batch List. Displays all batch instances waiting for review or validation. Click the Review or Validation
button at the top of the page to switch between the batch instances, and then double-click an
instance to open it in the Review or Validate page

• Review Validate. Displays the next batch instance ready for review or validation based on rules such
as priority or creation date.

2 In the left panel of the Review or Validate page, click the document containing the pages you want to
reorder, and then do one of the following:

Note: Selected documents are highlighted in gray.

• Review page. In the middle panel of the Review page, click and drag the page(s) to reorder as needed.

• Validate page. At the top of the left panel of the Validate page, click to access the document

page view. Click and drag the page(s) to reorder as needed, and then click again to close the
document page view.

Duplicate Pages

1 Hover over the left-hand tab to access the navigation menu, and then select one of the following from
the Operator options:

• Batch List. Displays all batch instances waiting for review or validation. Click the Review or Validation
button at the top of the page to switch between the batch instances, and then double-click an
instance to open it in the Review or Validate page.

• Review Validate. Displays the next batch instance ready for review or validation based on rules such
as priority or creation date.

2 In the left panel, click the document that you want to view.

Note: Selected documents are highlighted in gray.
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3 Select the page you want to duplicate in the document by doing one of the following:

• Review page. In the middle panel of the Review page, click the page that you want to duplicate.

• Validate page. At the top of the left panel of the Validate page, click to access the document
page view, and then click the page that you want to duplicate.

4 In the image toolbar, click to duplicate the selected page.

5 In the Duplicate Image dialog box, click the appropriate option to confirm that you want to duplicate the
selected page.

Once the duplication is confirmed, the new page appears in the left panel.

6 If needed, from the Validate page, click to close the document page view.

Magnify a Selected Area

1 Hover over the left-hand tab to access the navigation menu, and then select Batch List from the Operator
options.

2 On the Batch List page, click the Validation button, and then double-click an instance to open it in the
Validate page.

3 In the left panel, click the document that you want to view.

Note: Selected documents are highlighted in gray.

4 In the image toolbar, click to enable Magnification Mode.

Note: The Magnification Mode option is available for validation only.

5 In the right panel, view the image preview. For a multipage document, use the page options in the image

toolbar ( ) to move through the document.

6 Draw the area you want to magnify in the image by doing the following:

a Left-click once at the starting point (upper-left corner) of the area.

b Drag your mouse to highlight the entire area to magnify, and then left-click to finish selecting the
area.

A new panel displays over the image preview with the text (in the area you selected) magnified. If
needed, you can click and drag the panel to another area of the image preview; you cannot re-size the
panel.

98Chapter 5: Document Review and Validation



7 To magnify another area, repeat step 6.

The original panel is updated with text from the newly selected area.

8 To close the panel and disable Magnification Mode, click in the image toolbar.

Notes:

• Moving to another page or document in the batch closes the panel automatically, but Magnification
Mode remains enabled.

• When Magnification Mode is enabled, the following options in the image toolbar are disabled:

.

• When Magnification Mode is enabled, the following options in the image toolbar are enabled, but

function in relation to the magnified area, not the full image: . For example,
selecting a zoom option adjusts the size of the magnified area, not the full image. The magnification in
the panel resets when you select a new area to magnify.

Resize Images

1 Hover over the left-hand tab to access the navigation menu, and then select one of the following from
the Operator options:

• Batch List. Displays all batch instances waiting for review or validation. Click the Review or Validation
button at the top of the page to switch between the batch instances, and then double-click an
instance to open it in the Review or Validate page

• Review Validate. Displays the next batch instance ready for review or validation based on rules such
as priority or creation date.

2 In the left panel, click the document that you want to view.

Note: Selected documents are highlighted in gray.

3 Select the page that you want to adjust by doing one of the following:

• Review page. In the middle panel of the Review page, click the page that you want to adjust.

• Validate page. At the top of the left panel of the Validate page, click to access the document
page view, and then click the page that you want to adjust.
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4 In the image toolbar, click one of the following options to adjust the size of the preview for the selected
page:

• Zoom-in. Click to zoom-in on the image preview.

• Zoom-out. Click to zoom out of the image preview.

• Fit Image. Click to fit the image preview to the window size.

• Pop-out Image. Click to open the image preview in a separate window. You can click and drag the
edges of the window to resize it, or click and hold the title bar to move the window to another location
on the screen. To close the window and return the preview to its normal location on the right-hand

side of the screen, click in the window's title bar or in the image toolbar.

5 If needed, from the Validate page, click to close the document page view.
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Rescanning Pages
When reviewing or validating batch instances, you might encounter quality issues or other problems that
require you to re-scan a page. IDC provides an option to open the Web Scanner and re-scan a selected page.
In order to use the Re-Scan option, you must have a TWAIN-enabled scanner as well as the Web Scanner
installed. For more information about installing the Web Scanner, see "Web Scanner Installation" on page 8.

Rescan Pages

1 Hover over the left-hand tab to access the navigation menu, and then select one of the following from
the Operator options:

• Batch List. Displays all batch instances waiting for review or validation. Click the Review or Validation
button at the top of the page to switch between the batch instances, and then double-click an
instance to open it in the Review or Validate page.

• Review Validate. Displays the next batch instance ready for review or validation based on rules such
as priority or creation date.

2 In the left panel of the Review or Validate page, click the document you want to view.

Note: Selected documents are highlighted in gray.

3 Select the page you want to re-scan by doing one of the following:

• Review page. In the middle panel of the Review page, click the page that you want to re-scan in the
selected document.

• Validate page. At the top of the left panel of the Validate page, click to access the document
page view, and then click the page that you want to re-scan in the selected document.

4 In the main toolbar, click More > Scanning > Re-Scan.

The Web Scanner opens displaying the page you selected to re-scan.
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5 In the Web Scanner, do the following:

a In the main toolbar, click More > Rescan.

b Follow your scanner prompts to select the page to re-scan.

c After you are done scanning the page, click in the main toolbar.

d Click OK to confirm that you are finished scanning.

The Review or Validate page appears showing the batch instance.
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Inserting Pages
When reviewing or validating batch instances, you might encounter missing pages. IDC provides an option to
open the Web Scanner and insert an additional page(s) into the batch currently being viewed. In order to use
the Insert Page(s) option, you must have a TWAIN-enabled scanner as well as the Web Scanner installed. For
more information about installing the Web Scanner, see "Web Scanner Installation" on page 8.

Insert Pages

1 Hover over the left-hand tab to access the navigation menu, and then select one of the following from
the Operator options:

• Batch List. Displays all batch instances waiting for review or validation. Click the Review or Validation
button at the top of the page to switch between the batch instances, and then double-click an
instance to open it in the Review or Validate page.

• Review Validate. Displays the next batch instance ready for review or validation based on rules such
as priority or creation date.

2 In the left panel of the Review or Validate page, click the document you want to view.

Note: Selected documents are highlighted in gray.

3 In the main toolbar, click More > Scanning > Insert Page(s).

The Web Scanner opens.

4 In the Web Scanner, do the following:

a In the main toolbar, click More > Insert.

b Follow your scanner prompts to import the new page(s) for the batch instance.
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c After you are done scanning the new page(s), click in the main toolbar.

d Click OK to confirm that you are finished scanning.

The Review or Validate page appears showing the batch instance.
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About Reporting
Reporting provides information to Administrators about the performance of the IDC application. Multiple
reporting functions such as data migration, data calculation, and data cleanup are supported.

There are four classes of reports:

• Dashboard Reports. For more information, see"Dashboard Reports" on the next page.

• Throughput Reports. For more information, see"Throughput Reports" on page 112

• Advanced Reports. For more information, see "Advanced Reports" on page 130.

• Analysis Grid. For more information, see "Analysis Grid Reports" on page 148.
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Dashboard Reports
The Dashboard Reports page, by default, shows the following three tabs: System Health, System Reporting,
and Batch Processing.

• The System Health tab displays the status of IDC servers and services.

• The System Reporting tab shows batches per status (error, finished, ready for review), batches that are
awaiting manual operator input, sorted according to the time duration they have been in that state, and
batches grouped by priority.

• The Batch Processing tab shows information using number of pages in a batch to show pages processed
per unit time, pages processed per batch class, and average pages processed.

The dashboard is configurable as all of the report widgets available in the different tabs are interactive. The
widgets can be dragged, dropped, re-sized, and renamed with their respective tabs or moved across
different tabs. The tabs themselves are also configurable and can be renamed, deleted, and added. If you
make changes to the dashboard, your changes are saved, so you see the new configuration when you return
to the Dashboard Reports page. Saved dashboards are stored in this folder: {Ephesoft
SharedFolders}/SavedDashboards.

View Dashboard Reports

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Reports.

2 In the left-hand pane, click Dashboard Reports > Dashboard. By default, the System Health tab is
displayed.

On this tab you can:

• View the status of the IDC servers and services for the current date.
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• View the time duration for previous dates by typing another date in the Date box, or clicking to
select a date.

• View the Server and Services table to see the status of the Pickup Service, License Service, and Folder
Monitor.

3 Click the System Reporting tab to display overall batch processing metrics.

On this tab you can:

• View batches per status
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• View the batches ready for review compared to the batches ready for validation.

• View the number of batches in a priority (urgent) state by either pie chart or bar chart.

4 Click the Batch Processing tab to display page processing metrics.

109Chapter 6: Reporting



On this tab, you can:

• View the pages processed by either current date and time, day, month, or year. You can also choose
to see all batch classes or a specific batch class.

Note: The page count is cumulative over a period of time for recurring entries. For example, pages
processed for the month of January will show pages processed in January 2019 along with January
2020, and so on.

• View a bar chart that displays the number of pages processed per batch class. A marker line also
displays the average number of pages processed by all batch classes.
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• View gauge charts that display the average number of pages processed, according to batch and
according to document.

You can filter the data to be displayed by selecting a batch class from the Batch Class list; the
average number of pages of only the selected batch class are displayed in the gauges.

5 To add a new tab to the page, click the Add Tab icon.

6 Click the Add button for the panel you want to display, and then click Done.

7 To export the information in any of the reports, click for PDF, or for Excel.

8 To print any report, click .
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Throughput Reports
Throughput Reports can be configured using numerous parameters to analyze different aspects of IDC
performance. The rp_throughput_module_data table is used internally and stores the number of pages and
documents available in a batch instance at the end of a module execution. This table can be used to track
where pages are added or deleted in a batch instance by the Operator.

Throughput Reports filters allow you to set the parameters that generate reports. Depending on the value
selected in filters, the result is maximized or minimized. The available filters are shown below with a table
describing the options for each filter:

Filter Options

Filter Name Options Submit Type Description

Start Date Calendar Submit button Start date of the period for which executed
batch report has to be generated.

End Date Calendar Submit button End date of the period for which executed
batch report has to be generated.

Unit of Time • Per Second

• Per Minute

• Per Hour

Auto submit The selected unit of time taken to process the
batches.

Default Value: Per Minute

Include Operator
Time

• Yes

• No

Auto submit Option to include the operator time to review
and validate the documents/pages/batches.

Default value: No

Batch Class Batch class IDs of
all batches
accessible to logged
in user.

Auto submit IDs of the batch classes

Example: BC1 for Mailroom Automation
Template Batch Class

Default Value: ALL

Chart Type • Pie

• Bar

• Heatmap

Auto submit Chart type to represent the report.

Default value: Pie

Label Column Batch Class Auto submit

Data Column • Batches

• Pages

• Documents

Auto submit Generates the processed report on the basis
of type selected.

Default Value: Batches
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Default Filter Configuration
Default filter configurations for Throughput Reports are based on Start Date and End Date. These are
logically uniform. This ensures that data within the proper and relevant range is loaded for the reports.

Throughput Report Types
• Batch Class Throughput. This module generates a report of completed batches, based on the batch

class, start date, and end date. For more information, see "View Batch Class Throughput Reports" on the
next page.

• Batch Size Throughput. This module generates a report of completed batches based on the batch class,
start date, and end date. Reports are displayed as pages processed per batch size and pages processed
per unit time per batch size. For more information, see “View Batch Size Throughput Report” on
page 116.

• Week Days Throughput. This module generates a report for completed batches, based on the batch
class, start date, and end date. Reports are displayed as batches processed by day of the week and
batches processed per unit time for the day of the week. For more information, see“View Week Days
Throughput Report” on page 118.

• Hourly Throughput. This module generates a report for completed batches, based on batch class, start
date, and end date. Reports are displayed as pages processed by hour and pages processed per unit
time per hour. For more information, see “View Hourly Throughput Report” on page 120.

• Time-based Throughput. This module generates a report for completed batches, based on batch class,
start date, and end date. Reports are displayed as pages processed by end date and pages processed
per unit time by end date on a daily, monthly, quarterly, or yearly basis. For more information, see “View
Time Based Throughput Report” on page 122.

• Monthly Throughput. This module generates a report for completed batches, based on batch class, start
date, and end date. Reports are displayed as pages processed monthly and pages processed per unit
time monthly. “View Monthly Throughput Report” on page 124.

• Module Throughput. This module generates a report for completed batches, based on batch class, start
date, and end date. Reports are displayed as pages processed per module and pages processed per unit
time per module. For more information, see “View Module Throughput Report” on page 126.

• User Throughput. This module generates a user-oriented report for completed batches, based on the
time taken by user during the review and validation process. Batch class, start date, and end date can be
used as the filtering parameters. For more information, see “View User Throughput Report” on page 128.
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View Batch Class Throughput Reports

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Reports.

2 In the left-hand pane, click Throughput Reports > Batch Class Throughput.

The Batch Class Throughput report generates a report of completed batches and is made up of three
components:

• Throughput Reports filters. Determines the data source based on start and end date, and batch
class.

• Report body. Determines how the data is analyzed and displayed.

• Data grid. Displays information about the executed batches in tabular format.

3 Do the following in the Throughput Reports filters component:

a Type the Start Date and End Date, or click to select a date.

b Click a specific batch class in the Batch Class list, or click ALL to view all batch classes.

c Click a Unit of Time.

d Click Submit.
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4 Do the following in the report body component, which is made up of two separate reports:

a Select one of the following display types for the Sum of Pages by Batch Class report on the left side:

• Bar

• Pie

• Heatmap

b Modify the display options for this report using the drop-down lists as necessary.

c Select one of the following display types for the Sum of Pages Per <Unit of Time> by Batch Classreport
on the right side:

• Bar

• Pie

• Heatmap

d Modify the display options using the drop-down lists as necessary.

5 Do the following in the data grid component:

• Review the data from the charts in a tabular format.

• Use the page arrows to advance to the next page.

Note: The data grid tracks two additional items:

• Execution Time without Operator Duration (Unit of Time). Displays the execution time for each batch.

• Operator Duration (Unit of Time). Displays the time taken by the Operator to review and validate the
documents/pages in the batch.

6 To export the information in any of the reports, click for PDF, or for Excel.

7 To print any report, click .
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View Batch Size Throughput Report

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Reports.

2 In the left-hand pane, click Throughput Reports > Batch Size Throughput.

The Batch Class Throughput report generates a report of completed batches and is made up of three
components:

• Throughput Reports filters. Determines the data source based on start and end date, and batch
class.

• Report body. Determines how the data is analyzed and displayed.

• Data grid. Displays information about the executed batches in tabular format.

3 Do the following in the Throughput Reports filters component:

a Type the Start Date and End Date, or click to select a date.

b Click a specific batch class in the Batch Class list, or click ALL to view all batch classes .

c Click a Unit of Time.

d Click Yes or No to include the time it takes the operator to review and validate the batches.

e Click Submit.
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4 Do the following in the report body component, which is made up of two separate reports:

a Select one of the following display types for the Sum of Pages by Batch Size report on the left side:

• Bar

• Pie

• Heatmap

b Modify the display options for this report using the drop-down lists as necessary.

c Select one of the following display types for the Sum of Pages Per <Unit of Time> by Batch Size report
on the right side:

• Bar

• Pie

• Heatmap

d Modify the display options using the drop-down lists as necessary.

5 Do the following in the data grid component:

• Review the data from the charts in a tabular format.

• Use the page arrows to advance to the next page.

Note: The data grid tracks two additional items:

• Execution Time without Operator Duration (Unit of Time). Displays the execution time for each batch.

• Operator Duration (Unit of Time). Displays the time taken by the Operator to review and validate the
documents/pages in the batch.

6 To export the information in any of the reports, click for PDF, or for Excel.

7 To print any report, click .
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View Week Days Throughput Report

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Reports.

2 In the left-hand pane, click Throughput Reports > Week Days Throughput.

The Week Days Throughput report generates a report of completed batches and is made up of three
components:

• Throughput Reports filters. Determines the data source based on start and end date, and batch
class.

• Report body. Determines how the data is analyzed and displayed.

• Data grid. Displays information about the executed batches in tabular format.

3 Do the following in the Throughput Reports filters component:

a Type the Start Date and End Date, or click to select a date.

b Click a specific batch class in the Batch Class list, or click ALL to view all batch classes .

c Click a Unit of Time.

d Click Yes or No to include the time it takes the operator to review and validate the batches.

e Click Submit.
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4 Do the following in the report body component, which is made up of two separate reports:

a Select one of the following display types for the Sum of Pages by Day of the Week report on the left
side:

• Bar

• Pie

• Heatmap

b Modify the display options for this report using the drop-down lists as necessary.

c Select one of the following display types for the Sum of Pages Per <Unit of Time> by Day of the Week
report on the right side:

• Bar

• Pie

• Heatmap

d Modify the display options using the drop-down lists as necessary.

5 Do the following in the data grid component:

• Review the data from the charts in a tabular format.

• Use the page arrows to advance to the next page.

Note: The data grid tracks two additional items:

• Execution Time without Operator Duration (Unit of Time). Displays the execution time for each batch.

• Operator Duration (Unit of Time). Displays the time taken by the Operator to review and validate the
documents/pages in the batch.

6 To export the information in any of the reports, click for PDF, or for Excel.

7 To print any report, click .
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View Hourly Throughput Report

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Reports.

2 In the left-hand pane, click Throughput Reports > Hourly Throughput.

The Hourly Throughput report generates a report of completed batches and is made up of three
components:

• Throughput Reports filters. Determines the data source based on start and end date, and batch
class.

• Report body. Determines how the data is analyzed and displayed.

• Data grid. Displays information about the executed batches in tabular format.

3 Do the following in the Throughput Reports filters component:

a Type the Start Date and End Date, or click to select a date.

b Click a specific batch class in the Batch Class list, or click ALL to view all batch classes .

c Click a Unit of Time.

d Click Yes or No to include the time it takes the operator to review and validate the batches.

e Click Submit.
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4 Do the following in the report body component, which is made up of two separate reports:

a Select one of the following display types for the Sum of Pages by Hour of the Day report on the left
side:

• Bar

• Pie

• Heatmap

b Modify the display options for this report using the drop-down lists as necessary.

c Select one of the following display types for the Sum of Pages Per <Unit of Time> by Batch Class report
on the right side:

• Bar

• Pie

• Heatmap

d Modify the display options using the drop-down lists as necessary.

5 Do the following in the data grid component:

• Review the data from the charts in a tabular format.

• Use the page arrows to advance to the next page.

Note: The data grid tracks two additional items:

• Execution Time without Operator Duration (Unit of Time). Displays the execution time for each batch.

• Operator Duration (Unit of Time). Displays the time taken by the Operator to review and validate the
documents/pages in the batch.

6 To export the information in any of the reports, click for PDF, or for Excel.

7 To print any report, click .
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View Time Based Throughput Report

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Reports.

2 In the left-hand pane, click Throughput Reports > Time-Based Throughput.

The Time-Based Throughput report generates a report of completed batches and is made up of three
components:

• Throughput Reports filters. Determines the data source based on start and end date, and batch
class.

• Report body. Determines how the data is analyzed and displayed.

• Data grid. Displays information about the executed batches in tabular format.

3 Do the following in the Throughput Reports filters component:

a Type the Start Date and End Date, or click to select a date.

b Click a specific batch class in the Batch Class list, or click ALL to view all batch classes .

c Click a Unit of Time.

d Click Yes or No to include the time it takes the operator to review and validate the batches.

e Click Submit.
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4 Do the following in the report body component, which is made up of two separate reports:

a Select one of the following display types for the Sum of Pages by End Date Year report on the left
side:

• Line

• Curved Line

• Scatter Plot

b Modify the display options for this report using the drop-down lists as necessary.

c Select one of the following display types for the Sum of Pages Per <Unit of Time> by End Date Year
report on the right side:

• Line

• Curved Line

• Scatter Plot

d Modify the display options using the drop-down lists as necessary.

5 Do the following in the data grid component:

• Review the data from the charts in a tabular format.

• Use the page arrows to advance to the next page.

Note: The data grid tracks two additional items:

• Execution Time without Operator Duration (Unit of Time). Displays the execution time for each batch.

• Operator Duration (Unit of Time). Displays the time taken by the Operator to review and validate the
documents/pages in the batch.

6 To export the information in any of the reports, click for PDF, or for Excel.

7 To print any report, click .
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View Monthly Throughput Report

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Reports.

2 In the left-hand pane, click Throughput Reports > Monthly Throughput.

The Monthly Throughput report generates a report of completed batches and is made up of three
components:

• Throughput Reports filters. Determines the data source based on start and end date, and batch
class.

• Report body. Determines how the data is analyzed and displayed.

• Data grid. Displays information about the executed batches in tabular format.

3 Do the following in the Throughput Reports filters component:

a Type the Start Date and End Date, or click to select a date.

b Click a specific batch class in the Batch Class list, or click ALL to view all batch classes.

c Click a Unit of Time.

d Click Yes or No to include the time it takes the operator to review and validate the batches.

e Click Submit.
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4 Do the following in the report body component, which is made up of two separate reports:

a Select one of the following display types for the Sum of Pages by Month of the Year report on the left
side:

• Bar

• Pie

• Heatmap

b Modify the display options for this report using the drop-down lists as necessary.

c Select one of the following display types for the Sum of Pages Per <Unit of Time> by Month of the Year
report on the right side:

• Bar

• Pie

• Heatmap

d Modify the display options using the drop-down lists as necessary.

5 Do the following in the data grid component:

• Review the data from the charts in a tabular format.

• Use the page arrows to advance to the next page.

Note: The data grid tracks two additional items:

• Execution Time without Operator Duration (Unit of Time). Displays the execution time for each batch.

• Operator Duration (Unit of Time). Displays the time taken by the Operator to review and validate the
documents/pages in the batch.

6 To export the information in any of the reports, click for PDF, or for Excel.

7 To print any report, click .
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View Module Throughput Report

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Reports.

2 In the left-hand pane, click Throughput Reports > Module Throughput.

The Module Throughput report generates a report of completed batches and is made up of three
components:

• Throughput Reports filters. Determines the data source based on start and end date, and batch
class.

• Report body. Determines how the data is analyzed and displayed.

• Data grid. Displays information about the executed batches in tabular format.

3 Do the following in the Throughput Reports filters component:

a Type the Start Date and End Date, or click to select a date.

b Click a specific batch class in the Batch Class list, or click ALL to view all batch classes .

c Click a Unit of Time.

d Click Yes or No to include the time it takes the operator to review and validate the batches.

e Click Submit.
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4 Do the following in the report body component, which is made up of two separate reports:

a Select one of the following display types for the Sum of Pages by Module Name report on the left side:

• Bar

• Pie

• Heatmap

b Modify the display options for this report using the drop-down lists as necessary.

c Select one of the following display types for the Sum of Pages Per <Unit of Time> by Module Name
report on the right side:

• Bar

• Pie

• Heatmap

d Modify the display options using the drop-down list as necessary.

5 Do the following in the data grid component:

• Review the data from the charts in a tabular format.

• Use the page arrows to advance to the next page.

Note: The data grid tracks two additional items:

• Execution Time without Operator Duration (Unit of Time). Displays the execution time for each batch.

• Operator Duration (Unit of Time). Displays the time taken by the Operator to review and validate the
documents/pages in the batch.

6 To export the information in any of the reports, click for PDF, or for Excel.

7 To print any report, click .
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View User Throughput Report

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Reports.

2 In the left-hand pane, click Throughput Reports > User Throughput.

The User Throughput report generates a report of completed batches and is made up of two components:

• Throughput Reports filters. Determines the data source based on start and end date, and batch
class.

• Report body. Determines how the data is analyzed and displayed.

3 Do the following in the Throughput Reports filters component:

a Type the Start Date and End Date, or click to select a date.

b Click Submit.

c Under Rows, select one of the following options:

• Batches

• Operations Time

• User Effort

d Under Columns, select one of the following options:

• Batches

• Operations Time

• User Effort

e Under Values, select one or more of the following options:

• Average Duration in milliseconds

• Average Duration in Seconds

• Total Duration in milliseconds

• Total Duration in Seconds

f Under Filter, select one of the following filters:
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• Batches

• Operations Time

• User Effort

g Under View, select one or more of the following display types for the User Operation report:

• Table

• Chart

• Heatmap

If you choose Table, the following report appears:

4 To export the information in any of the reports, click for PDF, or for Excel.

5 To print any report, click .
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Advanced Reports
Advanced Reports are informative tools that assist Administrators in analyzing and optimizing the
parameters used by IDC in the Document Assembly and Extraction modules. Reports are generated for
batches that have the Review or Validation module present in the workflow. The following Advanced Reports
are available:

• Document Correction. A top-level reports that provide the user with all document types and the number
of manual corrections that the batch instance Operator made during the Document Assembly phase. For
more information, see “View Document Correction Reports” on page 133.

• Classification Accuracy. A mid-level report that aggregates corrections made to document types within
Classification with respect to all batches run. This gives the user a measure of accuracy for each
document type of every batch class. For more information, see "View Classification Accuracy Report" on
page 134.

• Classification Correction Details. A low-level report detailing corrections made to document types within
Classification. A classification correction is the result of a change in the document type of documents in
Review state by the user. For more information, see "View Classification Correction Details Report" on
page 136.

• Separation Accuracy. A mid-level report which aggregates corrections made to page counts in Review
module with respect to all batches run. This gives the user a measure of accuracy for each document
type of every batch class. For more information, see "View Separation Accuracy Report" on page 137.

• Separation Correction Details. A low-level report detailing corrections made to page counts within
Review module. Separation correction is the result of a split, merge, or deletion of a page in a document
during Classification. These result in the modification of the number of pages within a document. For
more information, see "View Separation Correction Details Report" on page 139.

• False Positive. False Positive is the opposite of an Unnecessary Review. It occurs when a document goes
through Classification without any issue, such as the document confidence being higher than the
threshold for the document type, but the document is changed by an Operator in Validation. For more
information, see "View False Positive Report" on page 140.

• Unnecessary Review. A document is labeled as an unnecessary review if it goes into review when the
document confidence is below threshold, and the operator simply confirms the auto-classified document
type. This issue is caused by thresholds that are set too high. By looking at the Unnecessary Review
report, the user can determine a more appropriate threshold to be set in IDC. For more information, see
"View Unnecessary Review Report" on page 141.

• Extraction Correction. Top level reports that provide the user with all document types and the number of
manual corrections during Extraction. Users are able to easily identify which document types (if any)
require further investigation. For more information, see "View Extraction Correction Report" on page 143.

• Field Correction. Mid-level reports that provide the user with all fields of all document types and the
number of manual corrections during Extraction. Users are able to easily identify which fields of
document types (if any) require further investigation. For more information, see "View Field Correction
Report" on page 145

• Field Correction Details. Low-level reports that provide the user with all fields of all document types and
the number of manual corrections during Extraction. Users are able to easily identify which fields of
document types (if any) require further investigation. For more information, see "View Field Correction
Details Report" on page 146
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Advanced Reporting Definitions
The following tables define the filter options and columns used throughout Advanced Reports.

Filter Options

Filter Name Options Description

Start Date Calendar Start date of the period for which executed batch report
has to be generated.

End Date Calendar End date of the period for which executed batch report
has to be generated.

Batch Class Batch class IDs of all
batches accessible to
logged in user.

IDs of the batch classes.

Example: BC1 for Mailroom Automation Template Batch
Class

Default Value: ALL

Document Type All types of documents
defined in each batch
class.

Types of documents defined in each Batch Class.

Default Value: ALL

Field Name All field names that
can be extracted.

Name of the fields that can extracted.

Default Value: ALL

Column Descriptions

Column Description

Accuracy The accuracy with which each document type of every batch class is
classified. It is measured in percentage.

Average Confidence Average confidence of all extracted values for all fields. extraction
correction.

Batch Class ID ID of the batch class.

Example: BC1 for Loose Sheet Template

Batch Instance ID ID assigned to each batch instance.

Batch Class Name Name of the batch class.

Example: Chart Batch

Change Ratio Change ration = (field change count/number of fields).

Classification Correction Count Number of classification corrections made by the reviewer.
Classification correction is the change in document type in the
Review module.

Confidence The score with which document is identified by IDC.
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Column Description

Document Type Types of documents defined in the batch class.

Document Type (Extraction
Correction)

Document type to which the corrected field belongs to.

Extraction Confidence (Field
Correction)

The confidence with which the value is extracted.

False Positive Count (Document
Correction)

Change of document type during validation when batch did not stop
for review, in the Review module.

Field Change Count Sum of field changes for all batches of this field, this document type,
and this batch class.

Field Name (Field Correction
Details)

Field name for which the value is corrected.

Field New Value Value updated by the validator for the field.

Field Old Value Value of the field extracted by IDC.

New Doc Type New document type selected by validator.

New Page Count Number of pages identified and updated by the reviewer.

Old Doc Type Document type identified by IDC.

Old Doc Type Threshold Document threshold value of old document type.

Old Page Count Number of pages identified by IDC.

Page Count Number of pages in each document.

Separation Accuracy The accuracy with which each page of the document type of every
batch class is separated, measured in percentage.

Separation Correction Count Number of page separations made by the reviewer. Separation
correction is the change in page count due to Split/Merge/Delete.

Start Date Date when the batch was picked up by IDC for execution.

Threshold The minimum confidence for the batch to be identified under
specified document.

Total Correction Count The total number of all types of corrections made by the reviewer or
validator.

Total Field Count Total number of fields for which values are extracted by IDC.

Unnecessary Review Count Number of unnecessary reviews made by the reviewer. It is the
number of document types or pages changed by user during review.
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View Document Correction Reports

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Reports.

2 In the left-hand pane, click Advanced Reports > Document Correction.

The Document Correction report is made up of the following components:

• Report filters. Determines the data source based on start and end date, batch class, and document
type.

• Report body. Determines how the data is analyzed and displayed.

• Data grid. Displays information about the executed batches in tabular format.

• Drilldowns and navigation. Allows you to access other reports from the data grid.

Note: For a complete list of column and filter descriptions, see “Advanced Reporting Definitions” on
page 131

3 Do the following in the report filters component:

a Type the Start Date and End Date, or click to select a date.

b Click a specific batch class in the Batch Class list, or click ALL to view all batch classes .

c Click a specific document type in the Document Type list, or click ALL to view all document types.

d Click Submit.

4 Do the following in the data grid component:

• Review the data from the charts in a tabular format.

• Click values in columns to display the report that correlates to the column.

• Use the page arrows to advance to the next page.
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5 In the report body component, Document Type vs Correction Count, click a color-coded bar to see the
corresponding advanced report.

For example, if you click a blue bar in the report above, the Classification Accuracy report appears,
displaying data specifically for the batch class - document type combination shown.

6 To return to the Document Correction report, click the link in the top left corner.

When you return to the Document Correction report, the data displayed is filtered to show only the batch
class - document type combination from the Classification Accuracy report.

7 To export the information in any of the reports, click for PDF, or for Excel.

8 To print any report, click .

View Classification Accuracy Report

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Reports.

2 In the left-hand pane, click Advanced Reports > Classification Accuracy.
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The Classification Accuracy report is made up of the following components:

• Report filters. Determines the data source based on start and end date, batch class, and document
type.

• Report body. Determines how the data is analyzed and displayed.

• Data grid. Displays information about the executed batches in tabular format.

• Drilldowns and navigation. Allows you to access other reports from the data grid.

Note: For a complete list of column and filter descriptions, see “Advanced Reporting Definitions” on
page 131

3 Do the following in the report filters component:

a Type the Start Date and End Date, or click to select a date.

b Click a specific batch class in the Batch Class list, or click ALL to view all batch classes .

c Click a specific document type in the Document Type list, or click ALL to view all document types.

d Click Submit.

4 Do the following in the data grid component:

• Review the data from the charts in a tabular format.

• Click values in the Accuracy column to display the Classification Correction Details report.

• Use the page arrows to advance to the next page.

5 In the report body component, Document Type vs Accuracy, click a blue bubble to see the corresponding
advanced report.

For example, if you click a blue bubble in the report above, the Classification Correction Details report
appears, displaying data specifically for the accuracy /document type combination shown.
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6 To return to the Classification Accuracy report, click the link in the top left corner.

When you return to the Classification Accuracy report, the data displayed is filtered to show only the
batch class - document type combination from the Classification Correction Details report.

7 To export the information in any of the reports, click for PDF, or for Excel.

8 To print any report, click .

View Classification Correction Details Report

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Reports.

2 In the left-hand pane, click Advanced Reports > Classification Correction Details.

The Classification Correction Details report is made up of the following components:

• Report filters. Determines the data source based on start and end date, batch class, and document
type.

• Data grid. Displays information about the executed batches in tabular format.

Note: For a complete list of column and filter descriptions, see “Advanced Reporting Definitions” on
page 131

3 Do the following in the report filters component:

a Type the Start Date and End Date, or click to select a date.

b Click a specific batch class in the Batch Class list, or click ALL to view all batch classes.

c Click a specific document type in the Document Type list, or click ALL to view all document types.

d Click Submit.
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4 Do the following in the data grid component:

• Review the data from the charts in a tabular format.

• Use the page arrows to advance to the next page.

5 To navigate to the Classification Accuracy report, click the link in the top left corner.

6 To export the information in any of the reports, click for PDF, or for Excel.

7 To print any report, click .

View Separation Accuracy Report

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Reports.

2 In the left-hand pane, click Advanced Reports > Separation Accuracy.

The Separation Accuracy report is made up of the following components:

• Report filters. Determines the data source based on start and end date, batch class, and document
type.

• Report body. Determines how the data is analyzed and displayed.
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• Data grid. Displays information about the executed batches in tabular format.

• Drilldowns and navigation. Allows you to access other reports from the data grid.

Note: For a complete list of column and filter descriptions, see “Advanced Reporting Definitions” on
page 131

3 Do the following in the report filters component:

a Type the Start Date and End Date, or click to select a date.

b Click a specific batch class in the Batch Class list, or click ALL to view all batch classes.

c Click a specific document type in the Document Type list, or click ALL to view all document types.

d Click Submit.

4 Do the following in the data grid component:

• Review the data from the charts in a tabular format.

• Use the page arrows to advance to the next page.

5 In the report body component, Document Type vs Accuracy, click a blue bubble to see the corresponding
advanced report.

For example, if you click a blue bubble in the report above, the Separation Correction Details report
appears, displaying data specifically for the accuracy /document type combination shown.

6 To return to the Separation Accuracy report, click the link in the top left corner.

When you return to the Separation Accuracy report, the data displayed is filtered to show only the batch
class - document type combination from the Separation Correction Details report.

7 To export the information in any of the reports, click for PDF, or for Excel.

8 To print any report, click .
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View Separation Correction Details Report

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Reports.

2 In the left-hand pane, click Advanced Reports > Separation Correction Details.

The Separation Correction Details report is made up of the following components:

• Report filters. Determines the data source based on start and end date, batch class, and document
type.

• Data grid. Displays information about the executed batches in tabular format.

Note: For a complete list of column and filter descriptions, see “Advanced Reporting Definitions” on
page 131

3 Do the following in the report filters component:

a Type the Start Date and End Date, or click to select a date.

b Click a specific batch class in the Batch Class list, or click ALL to view all batch classes .

c Click a specific document type in the Document Type list, or click ALL to view all document types.

d Click Submit.

4 Do the following in the data grid component:

• Review the data from the charts in a tabular format.

• Use the page arrows to advance to the next page.

5 To navigate to the Separation Accuracy report, click the link in the top left corner.
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6 To export the information in any of the reports, click for PDF, or for Excel.

7 To print any report, click .

View False Positive Report

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Reports.

2 In the left-hand pane, click Advanced Reports > Document Correction > False Positive.

The False Positive report is made up of the following components:

• Report filters. Determines the data source based on start and end date, batch class, and document
type.

• Report body. Determines how the data is analyzed and displayed.

• Data grid. Displays information about the executed batches in tabular format.

Note: For a complete list of column and filter descriptions, see “Advanced Reporting Definitions” on
page 131

3 Do the following in the report filters component:

a Type the Start Date and End Date, or click to select a date.

b Click a specific batch class in the Batch Class list, or click ALL to view all batch classes .

c Click a specific document type in the Document Type list, or click ALL to view all document types.

d Click Submit.

4 Do the following in the data grid component:

• Review the data from the charts in a tabular format.

• Use the page arrows to advance to the next page.
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5 In the report body component, Document Type vs Confidence, hover over a document type to see the
threshold and confidence values.

For example, a short bar indicates low confidence because of a high threshold. A high confidence with a
low or no threshold set indicates a potential false positive.

6 To navigate to the Document Correction report, click the link in the top left corner.

7 To export the information in any of the reports, click for PDF, or for Excel.

8 To print any report, click .

View Unnecessary Review Report

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Reports.

2 In the left-hand pane, click Advanced Reports > Document Correction > Unnecessary Review.
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The Unnecessary Review report is made up of the following components:

• Report filters. Determines the data source based on start and end date, batch class, and document
type.

• Report body. Determines how the data is analyzed and displayed.

• Data grid. Displays information about the executed batches in tabular format.

Note: For a complete list of column and filter descriptions, see “Advanced Reporting Definitions” on
page 131

3 Do the following in the report filters component:

a Type the Start Date and End Date, or click to select a date.

b Click a specific batch class in the Batch Class list, or click ALL to view all batch classes .

c Click a specific document type in the Document Type list, or click ALL to view all document types.

d Click Submit.

4 Do the following in the data grid component:

• Review the data from the charts in a tabular format.

• Use the page arrows to advance to the next page.

5 In the report body component, Document Type vs Confidence, hover over a document type to see the
threshold and confidence values.

6 To navigate to the Document Correction report, click the link in the top left corner.

7 To export the information in any of the reports, click for PDF, or for Excel.

8 To print any report, click .
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View Extraction Correction Report

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Reports.

2 In the left-hand pane, click Advanced Reports > Extraction Correction.

The Extraction Correction report is made up of the following components:

• Report filters. Determines the data source based on start and end date, batch class, and document
type.

• Report body. Determines how the data is analyzed and displayed.

• Data grid. Displays information about the executed batches in tabular format.

• Drilldowns and navigation. Allows you to access other reports from the data grid.

Note: For a complete list of column and filter descriptions, see “Advanced Reporting Definitions” on
page 131

3 Do the following in the report filters component:

a Type the Start Date and End Date, or click to select a date.

b Click a specific batch class in the Batch Class list, or click ALL to view all batch classes .

c Click a specific document type in the Document Type list, or click ALL to view all document types.

d Click Submit.
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4 Do the following in the data grid component:

• Review the data from the charts in a tabular format.

• Click values in the change ratio column to display the Field Correction report.

• Use the page arrows to advance to the next page.

5 In the report body component, Document Type vs Correction Count, click a color-coded bar to see the
corresponding advanced report.

For example, if you click a blue bar in the report above, the Field Correction report appears, displaying
data specifically for the batch class - document type combination shown.

6 To return to the Extraction Correction report, click the link in the top left corner.

When you return to the Extraction Correction report, the data displayed is filtered to show only the batch
class - document type combination from the Field Correction report.

7 To export the information in any of the reports, click for PDF, or for Excel.

8 To print any report, click .
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View Field Correction Report

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Reports.

2 In the left-hand pane, click Advanced Reports > Extraction Correction > Field Correction.

The Field Correction report is made up of the following components:

• Report filters. Determines the data source based on start and end date, batch class, and document
type.

• Report body. Determines how the data is analyzed and displayed.

• Data grid. Displays information about the executed batches in tabular format.

• Drilldowns and navigation. Allows you to access other reports from the data grid.

Note: For a complete list of column and filter descriptions, see “Advanced Reporting Definitions” on
page 131.

3 Do the following in the report filters component:

a Type the Start Date and End Date, or click to select a date.

b Click a specific batch class in the Batch Class list, or click ALL to view all batch classes.

c Click a specific document type in the Document Type list, or click ALL to view all document types.

d Click Submit.

4 Do the following in the data grid component:

• Review the data from the charts in a tabular format.

• Click values in the change ratio column to display the Field Correction Details report.

• Use the page arrows to advance to the next page.
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5 In the report body component, Field Name vs Change Ratio, click a color-coded bar to see the
corresponding advanced report.

For example, if you click a blue bar in the report above, the Field Correction Details report appears,
displaying data specifically for the field name/change ratio combination shown.

6 To return to the Field Correction report, click the link in the top left corner.

When you return to the Field Correction report, the data displayed is filtered to show only the field
name/change ratio combination from the Field Correction Details report.

7 To export the information in any of the reports, click for PDF, or for Excel.

8 To print any report, click .

View Field Correction Details Report

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Reports.

2 In the left-hand pane, click Advanced Reports > Extraction Correction > Field Correction > Field Correction
Details.
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The Field Correction Details report is made up of the following components:

• Report filters. Determines the data source based on start and end date, batch class, and document
type.

• Data grid. Displays information about the executed batches in tabular format.

Note: For a complete list of column and filter descriptions, see “Advanced Reporting Definitions” on
page 131

3 Do the following in the report filters component:

a Type the Start Date and End Date, or click to select a date.

b Click a specific batch class in the Batch Class list, or click ALL to view all batch classes.

c Click a specific document type in the Document Type list, or click ALL to view all document types.

d Click Submit.

4 Do the following in the data grid component:

• Review the data from the charts in a tabular format.

• Use the page arrows to advance to the next page.

5 To navigate to the Field Correction report, click the link in the top left corner.

6 To export the information in any of the reports, click for PDF, or for Excel.

7 To print any report, click .
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Analysis Grid Reports
Analysis Grid reports provide data and charts to analyze the Document Type Correction rate and Field Value
Correction rate corresponding to a batch class. With the grid reports, you can save your preferred report
below the data grid and view it any time by using the reload feature.

For more information about Analysis Grid reports, see "View Document Correction Analysis " below and
"View Field Correction Analysis" on the next page.

View Document Correction Analysis

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Reports.

2 In the left-hand pane, click Analysis Grid > Document Correction Analysis.

3 Click any of the following options to customize the analysis of your data:

• Formula. Adds a new column with a formula.

• Filter. Removes rows with a filter.

• Add Chart. Adds a chart.

• Add Crosstab. Creates a crosstab view.
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The following grid displays:

4 Click any of the following buttons below the table, if necessary:

• Refresh. Refreshes the grid data from the data source while maintaining any customizations made
during this session.

• Save. Saves your Analysis Grid customization to a file so you it may be recalled in a later session.

• Restore. Loads your saved grid customizations.

• Reset. Clears the settings automatically maintained during your session.

• Print. Prints the analysis grid.

View Field Correction Analysis

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Reports.

2 In the left-hand pane, click Analysis Grid > Field Correction Analysis.
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3 Click any of the following options to customize the analysis of your data:

• Formula. Adds a new column with a formula.

• Filter. Removes rows with a filter.

• Add Chart. Adds a chart.

• Add Crosstab. Creates a crosstab view.

The following grid displays:

4 Click any of the following buttons below the table, if necessary:

• Refresh. Refreshes the grid data from the data source while maintaining any customizations made
during this session.

• Save. Saves your Analysis Grid customization to a file so you it may be recalled in a later session.

• Restore. Loads your saved grid customizations.

• Reset. Clears the settings automatically maintained during your session.

• Print. Prints the analysis grid.
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About Troubleshooting
IDC provides you with multiple methods for troubleshooting issues with batch instances. A Troubleshoot
section is available when viewing execution details for a batch instance from the Batch Instance
Management page. Administrators can use the Troubleshoot section to download multiple types of logs,
batch instance files, and batch class files. Operators can also view the Optical Character Recognition
(OCR) layer to help troubleshoot documents that couldn't be classified, or that has missing or incorrect
data. For more information about these options, see "Viewing Log Files" on the next page or "Viewing the
OCR Layer" on page 155.
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Viewing Log Files
Administrators can access application log files when troubleshooting issues with a batch instance. The
main application log file is dcma-all.log. This log can be accessed from the IDC server
(/opt2/cmax/Ephesoft/Application/logs/dcma-all.log ) or downloaded from the Troubleshoot section of the
Batch Instance Management page.

Download the dcma-all.log

1 Hover over the left-hand tab to access the navigation menu, and then in the Administrator options, click
Batch Instance Management.

2 On the Batch Instance Management page, select a batch instance in the list to view its details.

3 In the Batch Execution Details area, click to open the Troubleshoot section.

4 In the Troubleshoot section, select the Logs check and the check box(es) for any other information you

want included in the download, and then click .

A .zip file of folders containing the information you selected to include is created and downloaded to
your computer.
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5 In your workstation's Downloads directory, locate the .zip file and extract the files.

Tip: The file name of the .zip includes the batch identifier (for example, 2020.1_BI14F_troubleshoot_
022822_157.zip).

6 Once the files are extracted to your workstation, navigate to the Application logs folder to view the dcma-
all.log.
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Viewing the OCR Layer
When troubleshooting a document that couldn't be classified, or that has missing or incorrect data, you can
access the OCR layer to view the metadata that was extracted from the document. Not all document pages
will have OCR. If there is no OCR data available for a page, a message appears at the top of the image
preview when you initially view the page. Additionally, you cannot select text or use Magnification Mode
when View OCR is selected.

View the OCR Layer

1 Hover over the left-hand tab to access the navigation menu, and then select one of the following from
the Operator options:

• Batch List. Displays all batch instances waiting for review or validation. Click the Review or Validation
button at the top of the page to switch between the batch instances, and then double-click an
instance to open it in the Review or Validate page.

• Review Validate. Displays the next batch instance ready for review or validation based on rules such
as priority or creation date.

2 In the left panel of the Review or Validate page, click the document you want to view.

Note: Selected documents are highlighted in gray.
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3 Select the page that you want to view by doing one of the following:

• Review page. In the middle panel of the Review page, click the page that you want to view.

• Validate page. At the top of the left panel of the Validate page, click to access the document
page view, and then click the page that you want to view.

Note: If there is no OCR data available for a page, a message appears at the top of the image preview
when you initially view the page.

4 In the image toolbar, click to view the metadata that was extracted from the document. When

finished viewing the OCR data, click to return to the image view.

5 If needed, from the Validate page, click to close the document page view.
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Glossary

Account Number (Acct#)

A numeric identifier assigned to a patient for an individual visit to a care site. Each time a patient visits a
medical facility for care, the patient receives a new account number. Quanum ECS uses the account num-
ber, along with the patient’s medical record number, to reference the collection of documents related to a
specific patient visit. See also Medical Record Number (MR#).

Administrators

Users with Administrator permissions can manage batches by adding new document types, building extrac-
tion and validation rules, and configuring work flows for each batch class. Administrators can also view
batches and restart or delete batches, if necessary.

Assigning Authority

See Medical Record Number Assigning Authority.

Attribute

See Document Attribute.

Bar Code

A machine-readable printed strip of vertical bars used for identification. Quanum ECS uses bar codes for
identifying batch types, document types, and patient index information (medical record numbers and/or
account numbers).

Base Medical Record Number

See Medical Record Number (MR#).

Batch

A set of paper documents that share identical scanning parameters, for example, paper size, page ori-
entation, scanning resolution, paper density, scanning mode, and bar code recognition characteristics.

Batch Instance

A batch instance contains all the documents that are being processed in a particular work session. The
batch instance may be made up of multiple documents of any document type supported by the batch class.

Batch Lock

A lock that is placed on a scanned batch whenever a user retrieves a batch. This lock remains on the batch
as long as the batch is open. The lock is released when the batch is closed. This lock protects the scanned
images in the batch from being edited or indexed by any other Quanum ECS users.

Batch Type

Scanner, imaging, and indexing information associated with each batch (set of paper documents that share
identical scanning parameters) that you scan into Quanum ECS. See also Batch.



Batch Type Header Sheet

The first page of each encounter batch to be scanned. Batch type header sheets provide indexing inform-
ation for a specific patient encounter.

Cabinet

A storage container that has an assigned name and may contain one or more drawers and numerous
folders. Typically, cabinets represent a collection of drawers and folders, which can be used to store non-
patient specific or administrative documents such as checks or remittance information. See also Drawer;
Folder.

Chart

A collection of documents and discrete information that represents documentation for an episode of care.

Document

The basic unit of information containing specific data that is stored and organized in a patient chart or
administrative folder. A document, in Quanum ECS , is very similar to a paper document in the sense that
both documents serve the same purpose—providing information. Both paper and Quanum ECS documents
have a name that is specific to a department or speciality. Both paper and Quanum ECS documents share
many similar attributes such as both can be one page, single sided, multi-paged, double-sided, and both
types can be added, edited, annotated, and signed. However, each time a document is revised, Quanum ECS
maintains a revision history that tracks each change and creates an audit trail. Documents are stored in
Quanum ECS in a variety of formats. The most commonly used document formats are as follows: Text (.txt
or .rtf.). A text file is a document that someone typed in a word processing program. Scanned Images (.tif,
.jpg, .gif, or .png). A scanned image file is a graphic file that someone created by scanning a document. Port-
able Document Format (.pdf). A PDF document is a generated file that consists of graphics and text. Dis-
crete Data (.rtf). A discrete data document is a file specific to Quanum ECS. The application creates a
fielded document based upon information that is stored in the Quanum ECS database. Electronic Forms. An
electronic form is a file specific to Quanum ECS. Electronic forms are based upon the form templates your
organization created using OpenText™ LiquidOffice™. See also Current Document; Document Instance;
Document Version; Obsolete Document.

Document Attribute

A piece of information that occurs within a document and that your organization defines as custom search
criteria.

Document Classification

Classification is the process used by IDC to identify document types so that the appropriate rules and logic
can be applied to extracted data. This allows IDC to ingest documents of multiple types in a single batch
and act upon each of them according to their own rules. Administrators are responsible for setting up clas-
sification rules and training IDC to recognize documents that match the classification rules using sample
documents.
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Document Ingestion

Ingestion is the first step in batch processing, and is also referred to as importing. IDC can ingest both elec-
tronic and paper documents. There are several methods for ingesting documents into IDC as well as con-
figurations that control how Transact manages the documents once they've been ingested. For example,
things such as local scanners, email import, and other ingestion methods can be used to upload document
batches into IDC.

Document Type

A document that belongs to a specific category. For example, document types for medical records might
include discharge summaries, invoices, payments received, operative reports, and admission forms. Docu-
ment types are defined for each batch class. Each document in a batch instance must be classified with a
document type.

Document Type Header Sheet

A page that introduces a document within a scanning batch. The document type header sheet is used to
index the subsequent pages to a specific document type.

Document Type Properties

Information (for example, minimum and maximum pages, whether or not the document is double sided, the
document type bar code, etc) for each document type that will be scanned in as part of a batch.

Document Validation

Validation is the process of verifying that the data IDC extracted from the batch is correct. If data is not cor-
rect, Operators can update the information or provide information that is missing. Validation must be com-
pleted in order for data and document export to occur.

Drawer

A storage container that contains one or more folders. Folders are used to store non-patient or admin-
istrative documents such as checks or remittance information. See also Cabinet; Folder.

Edit

A modification of a document that creates a new version.

Encounter

An episode of care that represents treatment of a patient for a specific issue. See also Account Number
(Acct#) or Visit.

Encounter Batch

A batch prepared for scanning that is composed of documents for one patient's account. See also Loose
Sheet Batch.

Event

Any action related to a request, including receiving the request, entering the request, printing a response,
etc.
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Event Date and Time

The date and time of a document, based upon the event that created the “need” for the document. For
example, the date and time of a document could be: the date and time the document was scanned into
Quanum ECS, when the lab test was reported, or when a transcription is either dictated or the date and
time of the event described in the dictation.

External Application

A third-party application that Quanum ECS is configured to start. Based upon how the third-party applic-
ation is configured to work with Quanum ECS patient-level or account-level information may automatically
be retrieved.

Extraction

During the extraction process, targeted data values are extracted from batch documents. IDC can extract
data using several methods including key-value extraction, table extraction, fixed-form extraction, and
more. Administrators define what information is extracted from the batch documents you process.

File Format

The electronic file format of the document. For example, the format may be .tif, .txt, .rtf, .pdf, .png, or .jpg.

Folder

A storage container that has an assigned name and may contain one or more non-patient specific or admin-
istrative documents. See also Cabinet; Drawer.

Group

A collection of users who share the same security permissions.

Header Sheet

See Batch Type Header Sheet and Document Type Header Sheet.

Loose Sheet Batch

A scanning batch composed of documents for several patients and charts. See also Encounter Batch.

Lost & Found

Quanum ECS uses medical record number and account number information to index a patient’s medical
information. When incoming patient information includes just the medical record number, just the account
number, or neither the medical record number nor the account number, Quanum ECS assigns the doc-
uments to the Lost & Found. The Lost & Found can only be accessed from the Lost & Found Search dialog
box in Chart Editor.

Master Patient Index (MPI)

A unique number generated by a third-party software system to identify a specific person across a health-
care system.
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Medical Record Number (MR#)

A unique number generated by the Hospital Information System (HIS) to identify a specific person as a
patient. The medical record number stored in Quanum ECS is composed of two elements: a medical record
number assigning authority and a base medical record number. The medical record number assigning
authority is generally a one or two character code that identifies what system or hospital assigned the med-
ical record number. The MRN Assigning Authority is optional and used in cases where hospitals have mul-
tiple facilities or systems that use similar MRN formats in order to avoid overlap between them. The base
medical record number is the actual medical number assigned by the system or hospital. Together the med-
ical record number assigning authority and the base medical record number make up a unique number, the
composite medical record number, that is stored in Quanum ECS. See also Account Number (Acct#).

Operators

Users with Operator permissions can upload documents for batch processing and review documents that
IDC has determined were not classified correctly. Operators can validate the exceptions and, if necessary,
manually populate the fields in question.

Optical Character Recognition (OCR)

Recognition of printed or written characters by computer. Each page of text is converted to a digital image
using a scanner and OCR technology is then applied to this image to produce a text file. The quality of
scanned images is important for OCR.

Quality Review

A Legacy Quanum ECS application that allows a user to perform quality review on scanned documents
before uploading them to the Quanum ECS database. All documents that are batch scanned are routed to
this application in Quanum ECS.

Scan Operator

A Legacy Quanum ECS application used to scan batches of documents into Quanum ECS.
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We’d Like to Hear From You

After you have used the documentation for this product, please take a moment to give us your feedback. To
do so, click the following link to open a PDF form and respond to the questions:

Click here to open the Feedback Form

After you have completed the form, do one of the following (from within the form) to submit your feedback:

• Email your responses. To send your responses to us electronically, click Submit by Email.

Your default email application is used to email the form content to us.

• Print the form. To print the completed form and then mail or fax it to us, click Print Form.

Our address and fax number appear at the bottom of the form.

Thank you!
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We’d Like to Hear From You 


After you have used the Quanum® Enterprise Content Solutions documentation, please take a moment to 
give us your comments. Respond to the questions below, and then click Submit by Email at the end of this 
form (or print and then fax your comments to us at your convenience).  Thank you! 
 


ü What sections/topics do you refer to most often?


ü When do you refer to the documentation?  Check all that apply.


ü How is the level of detail in the documentation?


ü Does the documentation adequately explain how to get started using the product?


ü If not, what information is missing?


ü How do you primarily search for information in the documentation?


ü Was there a topic or index entry you looked for, but couldn’t find?


 Getting started  Learning about new features  Performing a specific task  Troubleshooting


Too little Just right Too much


Yes No


Full text search Table of contents Index Scan


Yes No


ü If so, what was it?


ü Did you find any errors in the documentation?


Yes No


ü Any other comments about the documentation?







Please tell us about yourself (optional)


May we contact you for additional feedback?


Send your comments to us


Email Address:


Phone:


Address:


Company:


Title/Position:


Name:


Yes No


To email them, click the Submit by Email button and follow the prompts. To fax them, click the Print Form  
button and then fax them to 800.381.4048. 







